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Preface
. 

As part of an effort to improve and enhance the performance and capabilities of its product 
lines, EMC periodically releases revisions of its hardware and software. Therefore, some 
functions described in this document may not be supported by all versions of the software or 
hardware currently in use. For the most up-to-date information about product features, refer 
to your product release notes.

If a product does not function properly or does not function as described in this document, 
contact your EMC representative.

Revision history The following table presents the revision history of this document:

Revision Date Description

Audience This document is part of the EMC ProSphere documentation set, and is intended for 
use by system administrators and integrators responsible for deploying ProSphere.

Conventions used in this document
EMC uses the following conventions for special notices.

Note: A note presents information that is important, but not hazard-related.

01 April 2013 Initial version for 2.0 release. 

02 April 2013 Corrections to vCloud information.

03 June 2013 Initial version for 2.0.1.0 release. Added “Update Prosphere, 
including the Greenplum database” on page 124. Clarified 
“Configure Windows hosts and WS-MAN” on page 32.

04 June 2013 Corrections to Chapter 6, “Configure Switches”.

05 September 2013 Initial version for 2.0.1.2 release. Added Kerberos 
configuration steps in “Configure Kerberos authentication” on 
page 34. Clarified procedure for Unisphere for VMAX 
integration in “Integrate ProSphere with Unisphere for VMAX” 
on page 105.

06 December 2013 Initial version for 2.0.1.3 release. Corrected specification of 
.ovf file in “Deploy ProSphere” on page 66. Added information 
about vCenter security to “Requirements for performance 
data collection” on page 51.

07 July 2014 Enhancements to vApp installation.

08 September 2014 Made syntax correction in the Updates chapter.
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Preface
Typographical conventions
EMC uses the following type style conventions in this document:

Normal
• Names of interface elements (such as names of windows, dialog boxes, 

buttons, fields, and menus)
• Names of resources, attributes, pools, Boolean expressions, buttons, DQL 

statements, keywords, clauses, environment variables, functions, utilities
• URLs, pathnames, filenames, directory names, computer names, filenames, 

links, groups, service keys, file systems, notifications

Bold
• Names of commands, daemons, options, programs, processes, services, 

applications, utilities, kernels, notifications, system calls, man pages

• Names of interface elements (such as names of windows, dialog boxes, 
buttons, fields, and menus)

• What user specifically selects, clicks, presses, or types

Italic
• Full titles of publications referenced in text
• Emphasis (for example a new term)
• Variables

Courier

• System output, such as an error message or script 
• URLs, complete paths, filenames, prompts, and syntax when shown outside 

of running text

Courier bold

• Specific user input (such as commands) 

Courier italic

• Variables on command line
• User input variables 

Contacting Customer Support

Where to get help
EMC support, product, and licensing information can be obtained as follows.

Product information
For documentation, release notes, software updates, or for information about EMC 
products, licensing, and service, go to the EMC Online Support site (registration 
required) at:

http://support.emc.com

Technical support
For technical support, go to the EMC Online Support site and choose Support by 
Product. Enter ProSphere. On the Support page, you will see several options, 
including one for making a service request. Note that to open a service request, you 
must have a valid support agreement. Contact your EMC sales representative for 
details about obtaining a valid support agreement or with questions about your 
account.

Your comments
Your suggestions will help us continue to improve the accuracy, organization, and 
overall quality of the user publications. Send your general opinions of EMC 
documentation to:

techpubcomments@emc.com

Used in running (nonprocedural) text for:

Used in running (nonprocedural) text for:

Used in procedures for:

Used in all text (including procedures) for:

Used for:

Used for:

Used in procedures for:
EMC ProSphere Deployment Guide6
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Send your opinions of EMC ProSphere documentation to:

ProSphere_doc_comments@emc.com
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Deployment Checklist

This checklist summarizes the requirements that need to be in place before 
ProSphere™ is deployed. Keep this chapter and the following documents close at 
hand; they will guide you with detailed procedures for deploying ProSphere and 
setting up the network environment for ProSphere.

◆ EMC ProSphere Support Matrix 

◆ EMC ProSphere Security Configuration Guide

Note: If your corporation requires additional ProSphere security hardening to comply with the 
U.S. Federal or Department of Defense mandates, the ProSphere Federal Security Hardening 
Guide is available to all US Federal customers. Contact your EMC® representative to obtain a 
copy. These procedures must be performed immediately after you deploy ProSphere.

The chapter includes the following sections:

◆ VMware considerations ...............................................................................................  12
◆ Network considerations ...............................................................................................  12
◆ Storage considerations..................................................................................................  12
◆ Host considerations ......................................................................................................  12
◆ Switch considerations...................................................................................................  13

Note: ProSphere 2.0 runs on SuSE Linux Enterprise Server 11 SP2 (64 bit) which is installed as 
part of the Deploy OVF Template process and is included with the ProSphere 2.0 software.

Note: ProSphere does not support the installation of any third-party software, including 
security packages.
Deployment Checklist 11



Deployment Checklist
VMware considerations
❑ Ensure that you have at least one VMware ESX or ESXi server that is managed by 

a vCenter server.

❑ Identify a VMware ESXi, vCenter server, or vCloud Director server for the vApp 
installation. Consult your VMware administrator to ensure that all the required 
VMware infrastructure is in place.

❑ Allocate the required RAM each for the Discovery Engine, ProSphere 
Application, and Historical Database

Network considerations
❑ Collect the following network data for each of the three virtual machines and one 

for each Collector:

❑ A valid static IP address for the virtual machine.

❑ A fully qualified domain name for the virtual machine.

❑ A network mask for the IP address.

❑ A network gateway for the IP address.

❑ Primary and optional secondary DNS server IP addresses.

❑ Register all IP addresses used by ProSphere in DNS, and ensure that the reverse 
lookup through PTR records is supported.

❑ Check for firewall restrictions that may interfere with normal ProSphere 
operation in your VMware environment, broader network, and storage resource 
discovery. 

❑ Ensure that you have a license to deploy the ProSphere vApp in a DRS cluster.  
This requires at least an enterprise license with ESX.

❑ Clusters where ProSphere will be deployed must have at least two hosts and must 
be in DRS mode.

Storage considerations
❑ Download and install the EMC SMI-S Provider, used to discover EMC arrays.

❑ Check that Unisphere for VMAX is installed on Storage Area Network (SAN) 
attached hosts that have dedicated gatekeepers to Symmetrix arrays.  
VNX/CLARiiON arrays are discovered over TCP/IP.

❑ On Network Attached Storage (NAS), verify that licenses are enabled. 

❑ To consolidate and view Unisphere for VMAX alerts in ProSphere, install 
Unisphere for VMAX.

❑ To consolidate and view VNX alerts in ProSphere, install Unisphere Remote.

Host considerations
❑ WMI — required to discover physical Windows hosts and collect performance 

data using WMI access credentials.
EMC ProSphere Deployment Guide12
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❑ WS-MAN — required to discover Windows hosts using WS-MAN access 
credentials.

❑ SSH - root and sudo — required to discover physical UNIX hosts. For the 
non-root user, install sudo on the host and configure the sudoer file.

❑ VMware Infrastructure — required to discover VMware environments. ESX 
server or vCenter credentials with Browse–Datastore and Storage Views–View 
permissions are required.

❑ WinRM service — required to discover Windows hosts using WS-MAN access 
credentials (optional).

❑ EMC— supported HBA drivers and firmware and HBA vendor-specific SNIA 
libraries (required for all operating systems)

❑ iostat — required for performance data collection on Linux (RedHat and SuSE) 
and Solaris hosts.

❑ sar — required for performance data collection on AIX and HP-UX hosts.

Switch considerations
❑ Install Connectrix Manager Converged Network Edition (MCNE) or Connectrix 

Manager Data Center Edition (DCE) on a separate host. 

❑ If you are discovering Brocade switches, install the Brocade SMI Agent. CMCNE 
contains the Brocade SMI Agent (Headless), which is required for data 
integration. The Brocade SMI Agent is available with all versions of CMCNE. The 
website support.emc.com provides CMCNE software and documentation.

❑ HTTP or HTTPS access credentials for the Brocade SMI Agent to discover Brocade 
switches.

❑ Discover fabrics to be managed in the EMC SMI-S Provider before discovering it 
from ProSphere. For installation instructions, go to support.emc.com.

❑ SNMP v1, v2, and v3 access credentials to discover Cisco switches. 

❑ Zoning requirements and conventions for passive discovery of hosts.

❑ To consolidate and view Cisco alerts in ProSphere, install Cisco Prime Data 
Center Network Manager (DCNM).
Switch considerations 13
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Overview

This chapter provides an overview of environment configuration and deployment.

The chapter includes the following sections:

◆ ProSphere terminology.................................................................................................  16
◆ Deployment task reference table.................................................................................  18

Note: If you are applying ProSphere updates, such as installing ProSphere 2.0, go directly to 
Appendix A, “Updates and Backups”.
Overview 15



Overview
ProSphere terminology
The following terms related to ProSphere are used in this document:

◆ A “virtual machine” is a software computer that runs an operating system and 
applications. Multiple virtual machines can run concurrently on the same host. 
The virtual machines that form the core of ProSphere are: the ProSphere 
Application, the Discovery Engine, and the Historical Database. Some 
deployments include one or more instances of an additional virtual machine: the 
Discovery Engine Collector (Collector). Figure 1 on page 17 illustrates these 
virtual machines.

◆ A “vApp”, shown in Figure 1 on page 17 is a software solution optimized for the 
cloud, consisting of multiple virtual machines, packaged and maintained as a 
single entity in OVF format. ProSphere is deployed as a VMware vApp, 
configured as a collection of interdependent virtual machines.
EMC ProSphere Deployment Guide16



Overview
Figure 1 ProSphere Architecture

◆ A “virtual appliance” is a software solution composed of one or more virtual 
solutions. A virtual appliance is packaged as a unit by an appliance vendor and is 
deployed, managed, and maintained as a unit. ProSphere is also a virtual 
appliance.
ProSphere terminology 17



Overview
◆ A “ProSphere Application” (1 in the figure) manages ProSphere components, 
controlling activity with the Historical Database, the Discovery Engines, and user 
Consoles.

◆ A “Historical Database” (2) stores attribute and performance data for all 
discovered objects. It receives data from the Discovery Engines and is managed 
by the ProSphere Application.

◆ A “Discovery Engine” (3) discovers logical and physical resources in the network 
and supplies attributes and performance data to the Historical Database. It 
controls any of the optional Discovery Engine Collectors, and is managed by the 
ProSphere Application.

◆ A “Discovery Engine Collector” (4, 5, 6, and 7) discovers logical and physical 
resources in the network and supplies attributes and performance data to the 
Discovery Engine. Collectors appear in scale-out deployments. While there is 
only one Discovery Engine, there may be many Collectors. In the figure, Collector 
4 is inside the firewall the Collectors 5 through 7 are outside the firewall.

Deployment task reference table
Table 1 on page 18 is a guide to documentation on deployment-related tasks.

Table 1 Documentation references

To... Refer to...

Get started...

Learn about ProSphere architecture Architecture chapter in the EMC ProSphere 
Administrator Guide

Decide whether and how to scale out a ProSphere 
deployment

EMC ProSphere Performance and Scalability 
Guidelines

Prepare the network and its components (hosts, arrays, 
and switches)

• See “Deployment Checklist”  on page  11 for a list of 
requirements before deployment

• Configuration chapters in this manual for software 
configuration procedures

• EMC ProSphere Support Matrix for supported 
versions of hardware and software

• EMC ProSphere Release Notes for supplemental 
information about a specific release

Change system passwords EMC ProSphere Security Configuration Guide

Broad overview of configuration, deployment, and 
product use

EMC ProSphere User Guide

Note: Subsequent references are to chapters in this 
manual.

Verify that the VMware infrastructure meets the base infrastructure requirements

Verify that your VMware infrastructure meets the base 
infrastructure requirement

Chapter 3, “Prepare VMware Infrastructure”

Verify that you have the VMware credentials required 
for deployment
EMC ProSphere Deployment Guide18



Overview
Verify that you meet the virtual hardware requirements

Obtain VMware information needed in the deployment 
process

Configure the ProSphere environment to allow successful discoveries

Configure third-party software used to discover hosts 
and related performance data

Chapter 4, “Configure Hosts”

Configure array data providers (software that exposes 
array management information)

Chapter 5, “Configure Storage Systems”, Chapter 6, 
“Configure Switches”

Configure Cisco and Brocade switches and fabrics Chapter 6, “Configure Switches”

Deploy ProSphere from vSphere Client

Download the deployment files (.ovf file and .vmdk files) 
to a location accessible to the vSphere Client.

Chapter 7, “Deploy ProSphere”

Open the vSphere Client and connect to the vCenter 
server managing the VMware environment.

Enter information at the Deploy OVF Template dialog 
box. This includes information about the resource pool 
for the ProSphere vApp, the datastore, and the 
ProSphere virtual machines.

Use a vSphere Client to download the files and transmit 
them to an ESX or ESXi server.

OR

Deploy ProSphere from vCloud Director Chapter 7, “Deploy ProSphere”

Create a vCloud catalog.

Upload deployment files into a vApp template in the 
catalog.

Deploy ProSphere from the vApp template.

Add NICs for isolated networks Chapter 8, “Add NICs for Isolated Networks”

Deploy Collectors, if needed to scale out the 
deployment.

Chapter 9, “Deploy Collectors”

Deploy a Secondary ProSphere Application, if 
needed to enhance performance

Chapter 10, “Deploy Secondary ProSphere Application”

Table 1 Documentation references

To... Refer to...
Deployment task reference table 19
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Perform post-deployment tasks

Synchronize ProSphere deployments, if you have more 
than one deployment

Chapter 11, “Post-Deployment Tasks”

Deploy organization-trusted certificates through the 
ProSphere Console

Apply updates Appendix A, “Updates and Backups”

Back up ProSphere Appendix A, “Updates and Backups”

Table 1 Documentation references

To... Refer to...
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Prepare VMware 
Infrastructure

This chapter provides information about infrastructure requirements and how to 
prepare your VMware environment for ProSphere deployment. The following 
sections detail infrastructure requirements:

◆ Base VMware infrastructure requirements checklist ...............................................  22
◆ VMware user credentials .............................................................................................  22
◆ Virtual hardware requirements...................................................................................  23
◆ Provision thick and thin disks.....................................................................................  24
◆ VMware Tools on the ProSphere vApp .....................................................................  24
◆ Browser requirements...................................................................................................  24
◆ Obtain VMware infrastructure requirements (vSphere Client)..............................  25
◆ Obtain VMware infrastructure requirements (vCloud Director)...........................  26
Prepare VMware Infrastructure 21



Prepare VMware Infrastructure
Base VMware infrastructure requirements checklist

IMPORTANT!
Consult with your VMware administrator to ensure that all the required VMware 
infrastructure is available before you start ProSphere deployment.

The base VMware infrastructure requirements include:

❑ A VMware vSphere virtualized computing environment.

IMPORTANT!
ProSphere does not validate hostnames. You must independently register with 
DNS (1) hostnames you specify for virtual machines (2) hostnames for hosts 
that ProSphere will discover (3) hostnames for hosts about which information 
will be collected in reports. Failing to register hostnames with the 
corresponding DNS may prevent normal operation of ProSphere. 

❑ An installed vCenter server.

❑ An installed VMware ESX or ESXi server running in the vSphere environment.

❑ A data store with a minimum 600 GB of free space for the unzipped appliances 
and for the downloaded zipped appliance image files. This data store will hold 
the appliance images needed to run ProSphere.

❑ If you are deploying ProSphere in a VMware cluster setup, ESX or ESXi servers 
should be time-synchronized to an external Network Time Protocol (NTP) server. 
However, the product can be deployed on a single ESX server, if the server meets 
hardware requirements mentioned in “Virtual hardware requirements” on 
page 23. If you deploy on a single ESX server, in the data center section of vCenter 
set the environment for a single ESX server and not a cluster. 

❑ The clock settings of all the ESX or ESXi servers present within the cluster are 
synchronized. Unsynchronized ESX or ESXi servers might lead to ProSphere 
discovery issues.

Note: To take advantage of vSphere features that enhance availability and flexibility of a virtual 
infrastructure, EMC recommends that you deploy ProSphere on an ESX or ESXi server cluster.

Note: If using vCloud for deployment of ProSphere, the vCloud administrator should ensure 
that the virtual datacenter created has sufficient hardware resources as per the specifications in 
EMC ProSphere Performance and Scalability Guidelines.

VMware user credentials
ProSphere deployment is performed by a user logged into the VMware 
infrastructure. Table 2 on page 23 specifies the user credentials required by VMware 
for an installer.
EMC ProSphere Deployment Guide22



Prepare VMware Infrastructure
Table 2 VMware credentials required for ProSphere deployment

VMware infrastructure resource Required user credentials

• Allocate space
• Browse data store
• Low-level file operations

• Create Virtual Appliance
• Delete Virtual Appliance
• Reconfigure Virtual Appliance

• Assign vApp to Resource Pool
• Assign VM to resource pool
• Migrate
• Query VMotion

Virtual hardware requirements
ProSphere administrators can use this information to make their deployment 
decisions based on current and expected hardware resource utilization.

Data store

Host Local Operators

Host Profile View

Network Assign Network

Resource

vApp Full permissions

Virtual machine Full permissions

Table 3 Virtual hardware requirements

Virtual Machine Virtual Processor RAM / Memory Storage

Requirements for an unscaled deployment

ProSphere Application Four 64-bit CPUs 8 GB

Note: Before 
discovering 
ProSphere capacity 
data using the 
Solution Pack for 
ProSphere-SCA, 
contact Customer 
Support to increase 
the memory of the 
ProSphere 
Application to 12 GB, 
and increase the 
memory of the 
Topology Service 
from 1 GB to 2 GB.

230 GB

Discovery Engine Four 64-bit CPUs 8 GB 40 GB

Historical Database Four 64-bit CPUs 6 GB 230 GB
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Prepare VMware Infrastructure
Note: No special VMware configuration procedures are required before deploying ProSphere.

Provision thick and thin disks
When making a decision to use thick or thin provisioning, consider the future storage 
capacity requirements of all the virtual machines on the same datastore, and the disk 
space usage of ProSphere Application and Historical Database. EMC ProSphere 
Performance and Scalability Guidelines details the storage considerations for ProSphere 
deployments.

VMware Tools on the ProSphere vApp
Because ProSphere installation performs the updates to VMware Tools on ProSphere 
virtual machines, VMware Tools are listed as “unmanaged” when viewed in the 
vSphere client software. This means they are not managed by the vCenter server. 

Browser requirements
ProSphere requires Adobe Flash Player version 10.2.153.1 or later, which is available 
for most popular browsers including Microsoft Internet Explorer, Mozilla Firefox, 
and Google Chrome. If your Flash player is older than this version, upgrade to the 
latest available Flash player. 

ProSphere is best displayed on a monitor set to a resolution of 1024x768 or higher.

Transport Layer Security (TLS) 1.0 is required as the security setting for the web 
browser.

Ensure that your browser accepts cookies and that pop-up blockers are disabled. For 
browsers in which the launching window does not automatically close (for example, 
Microsoft Internet Explorer), it is necessary to use a new browser instance for each 
ProSphere login. The browser retains cookies directing it to the previous ProSphere 
Application, even after you enter the URL for a new ProSphere website.

Note: A browser instance can be reused if the cookies for the appropriate ProSphere website 
are deleted.

Requirements, for a scaled deployment with an additional Discovery Engine Collector (Collector)

Additional Collector Two 64-bit CPUs 6 GB 30 GB (For Thick Disk) 
2.2 GB (For Thin Disk)

Requirements for a deployment with an additional (Secondary) ProSphere Application

Secondary ProSphere 
Application

Two 64-bit CPUs 4 GB 230 GB

Table 3 Virtual hardware requirements

Virtual Machine Virtual Processor RAM / Memory Storage
EMC ProSphere Deployment Guide24



Prepare VMware Infrastructure
Obtain VMware infrastructure requirements (vSphere Client)
This section is for users who deploy ProSphere from vSphere Client. 

Obtain the following information that you are required to specify during 
deployment. Space is provided below to write down these values. 

IMPORTANT!
Use only a vCenter to connect the vSphere Client to an ESX server. Attempts to 
deploy directly to an ESX server will fail.

◆ The IP address or hostname for the vCenter server managing the VMWare 
environment. The username and password to connect the vSphere Client to the 
server.

VMware server IP address or hostname: _____________________________

Username: _______________________________________________________

Password: _______________________________________________________

◆ Verify that you have privileges needed to deploy a vApp.

◆ The name for this deployment of ProSphere (for example, Local ProSphere 
deployment).

Name for the ProSphere vApp: __________________________________________

◆ The following infrastructure location for the ProSphere vApp:

Inventory Location: _______________________________________________

Host/Cluster: ____________________________________________________

Disk format (Thick/Thin):__________________________________________

Resource Pool: ___________________________________________________

◆ The name of a data store in the local vSphere environment to hold the ProSphere 
virtual machine images.

Data store: _______________________________________________________

◆ The names of the vSphere network(s) in which to deploy each of the three virtual 
machines for the ProSphere vApp. The virtual machines may be deployed in 
separate subnets.

ProSphere network: ________________________________

Discovery Engine network: _____________________________________

Historical Database network: _______________________________________

Collector network: _______________________________________

Collector network: _______________________________________

Collector network: _______________________________________

Collector network: _______________________________________

◆ The desired secure access and network properties for the Historical Database 
virtual machine, including:

DNS servers (separated by commas): 

_________________________________________________________________

Search domain strings (separated by spaces):
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_________________________________________________________________

Hostname: _______________________________________________________

IP address: ______________________________________________________

Netmask: _______________________________________________________

Subnet gateway: _________________________________________________

◆ The desired secure access and network properties for the Discovery Engine 
virtual machine, including:

DNS servers (separated by commas): 

_________________________________________________________________

Search domain strings (separated by spaces):

_________________________________________________________________

Hostname: _______________________________________________________

IP address: ______________________________________________________

Netmask: ________________________________________________________

Subnet gateway: __________________________________________________

◆ The desired secure access and network properties for the ProSphere Application 
virtual machine, including:

DNS servers (separated by commas):

_________________________________________________________________

Search domain strings (separated by spaces):

_________________________________________________________________

Hostname: _______________________________________________________

IP address: ______________________________________________________

Netmask: ________________________________________________________

Subnet gateway: __________________________________________________

Obtain VMware infrastructure requirements (vCloud Director)
This section is for users who deploy ProSphere from vCloud Director. 

Obtain the following information that you are required to specify during 
deployment. Space is provided below to write down these values. 

◆ The IP address or hostname for the vCloud Director server. 

◆ The username and password to log in to the vCloud Director server.

VMware Director server IP address or hostname:

_________________________________________________________________

Username: _______________________________________________________

Password: _______________________________________________________

◆ Verify that you have privileges in vCloud Director that allow you to create a 
catalog, upload a vApp template to the catalog, and deploy a vApp template. For 
information on Predefined Roles and Their Rights, go to 
http://pubs.vmware.com
EMC ProSphere Deployment Guide26



Prepare VMware Infrastructure
◆ The name for this deployment of ProSphere (for example, Local ProSphere 
deployment).

Name for the ProSphere vApp: __________________________________________

◆ The following details for ProSphere vApp deployment:

Virtual datacenter name____________________________________________

IP allocation (should be Static-Manual):______________________________

Storage profile:____________________________________________________

Lease information:_________________________________________________

◆ The names of the network(s) in the virtual datacenter inventory where you wish 
to deploy the virtual machines for the ProSphere vApp. The virtual machines 
may be deployed in separate subnets.

ProSphere network: ________________________________

Discovery Engine network: _____________________________________

Historical Database network: _______________________________________

Collector network: _______________________________________

Collector network: _______________________________________

Collector network: _______________________________________

Collector network: _______________________________________

Secondary ProSphere network:_____________________________

◆ The desired secure access and network properties for the Historical Database 
virtual machine, including:

DNS servers (separated by commas): 

_________________________________________________________________

Search domain strings (separated by spaces):

_________________________________________________________________

Hostname: _______________________________________________________

IP address: ______________________________________________________

Netmask: _______________________________________________________

Subnet gateway: _________________________________________________

◆ The desired secure access and network properties for the Discovery Engine 
virtual machine, including:

DNS servers (separated by commas): 

_________________________________________________________________

Search domain strings (separated by spaces):

_________________________________________________________________

Hostname: _______________________________________________________

IP address: ______________________________________________________

Netmask: ________________________________________________________

Subnet gateway: __________________________________________________

◆ The desired secure access and network properties for the ProSphere Application 
virtual machine, including:
Obtain VMware infrastructure requirements (vCloud Director) 27



Prepare VMware Infrastructure
DNS servers (separated by commas):

_________________________________________________________________

Search domain strings (separated by spaces):

_________________________________________________________________

Hostname: _______________________________________________________

IP address: ______________________________________________________

Netmask: ________________________________________________________

Subnet gateway: __________________________________________________
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Configure Hosts

This chapter provides instructions for the installation and configuration of 
third-party software used to discover hosts and related performance data.

The chapter includes the following sections:

◆ Avoid underscores in hostnames................................................................................  30
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Avoid underscores in hostnames
Hostname labels can contain only the lowercase ASCII letters “a” through “z”, the 
digits “0” through “9”, and the hyphen (“-”). No other symbols, punctuation 
characters, or white spaces are permitted.

If ProSphere encounters a host name with an underscore, users can be prevented 
from logging in.

You can confirm the situation by searching the log files for the following string:

IllegalArgumentException: Host cannot be null

Characters not allowed in hostnames
Do not include the following characters in hostnames:

◆ comma (,)

◆ tilde (~)

◆ colon (:)

◆ exclamation point (!)

◆ at sign (@)

◆ number sign (#)

◆ dollar sign ($)

◆ percent (%)

◆ caret (^)

◆ ampersand (&)

◆ apostrophe (')

◆ period (.)

◆ parentheses (())

◆ braces ({})

◆ underscore (_)

◆ white space (blank)

DNS registration
Make sure the hostnames are in DNS format with FQDN, and IP addresses must be 
registered with the appropriate domain name servers and resolve for a reverse DNS 
lookup. In hostnames, do not include underscores or characters listed in “Characters 
not allowed in hostnames” on page 30.

Validate HBAs
All host platforms require the following to discover SNIA-qualified HBA-related 
information:

◆ EMC-supported host bus adapter (HBA) drivers and firmware. The HBA driver 
installed must be SNIA HBA API 2.0 compliant. The EMC ProSphere Support 
Matrix provides specific details.
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◆ The vendor-specific SNIA libraries must be installed on the target host.

Note:  
The HBA model number and part number should be verified before updating the hosts 
with SNIA libraries for HBA. 
 
You can install the SNIA library in one of the following ways: 
- As part of HBA driver installation package. 
- Install latest version of HBAnywhere (for Emulex installations) or SAN Surfer (for Qlogic 
installation). 
 
To discover an HP-UX host with a multi-port Fibre Channel card, the package CommonIO 
bundle 0812(Dec 2008) or later should be present on the host to obtain the updated 
FC-SNIA file set.

To validate that the appropriate SNIA libraries are installed, download and run the 
inq application from the EMC Online Support Site using the following procedure:

1. From the EMC Online Support Site, click Search.

2. In the Search field type inq utility.

3. Select the latest version of inq.

4. Select the operating system for your host.

5. Download inq and follow the provided installation instructions.

6. Run the following command on the host after installation: 
 
Inq -hba  

If the command lists the HBAs, then the SNIA libraries are properly installed, 
which means that ProSphere can discover the HBAs.
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EMC ProSphere/SCA Host Configuration Utility
The EMC Host Configuration Utility helps customers verify the settings discussed in 
this chapter, which enable a Windows host to be successfully discovered in ProSphere 
or in SCA. Optionally, the utility automatically configures the settings. The utility is 
available on the EMC Online Support Site (support.emc.com).

Configure Windows hosts and WS-MAN 
This section describes how to configure WS-MAN to work with ProSphere. WS-MAN 
is the preferred discovery mechanism for Windows 2008 and later. 

Note: On Windows 2012, before performing steps in this section, change network connectivity 
from public to private. Go to Control Panel. Select Network and Internet. Under Network and 
Sharing Center, click Connect to a network. On the right-hand screen, right-click Network-> 
Turn Sharing on or off. Click Yes, Turn on sharing and connect to devices. After performing 
the steps in this section, set network connectivity as preferred.

Note: ProSphere will not copy the INQ binary executable on Windows hosts when discovery is 
scheduled using the WS-MAN access profile.

Note the following:

◆ Discovery must be done under the access profile of a user that is an Administrator 
or a member of the Administrators group. These credentials are entered as 
WS-MAN credentials in ProSphere. The EMC ProSphere Administrator Guide 
explains how to create access credentials.

◆ The user account used for discovery must be permitted access to the host to be 
discovered.

Windows Remote Management (WinRM) is the Microsoft implementation of the 
WS-MAN protocol.  Manually perform the following steps to prepare to discover 
configuration items (CIs) with WinRM. All of the following commands should be run 
from a Windows Powershell prompt.

To Configure WinRM for use with ProSphere, follow these steps on the host you wish 
to discover.

1. Run winrm quickconfig to enable a firewall exception for WS-MAN. Enter y 
when prompted.

In case the command fails, ensure the Windows Remote Management service is 
running and the Startup Type is set to Automatic. Then run the following 
commands individually from a Windows Powershell prompt:

a. Get-WmiObject -computer $server Win32_Service -Filter 

“Name=‘WinRM’” | Start-Service 
 
In this command, $server refers to the target Windows hostname.

b. winrm create winrm/config/listener?Address=*+Transport=HTTP

c. netsh advfirewall firewall add rule name=“Windows Remote 
Management(Http-In)” dir=in action=allow program="System" 
protocol=TCP localport="5985" profile="Domain,Public,Private" 
enable=yes
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Note: If you wish to configure WinRM to use HTTPS transport instead, refer to 
http://support.microsoft.com.

For Windows Server 2003 hosts such as R2 hosts, for which WinRM is not 
installed by default, WinRM is available as the Hardware Management feature 
through the Add/Remove System Components feature in the Control Panel 
under Management and Monitoring Tools. Complete installation and information 
about configuring WinRM using the Winrm command-line tool is available online 
in the “Hardware Management Introduction”at http://technet.microsoft.com, 
which describes the WinRM and the IPMI features in Windows Server 2003 R2. If 
you use Windows 2003 and need to install WinRM on a large number of servers, 
ask your Windows Administrator for assistance and direct him or her to the 
“Hardware Management Introduction”.

2. Enable authentication on the WinRM service. The authentication scheme can be 
Basic or Kerberos.

a. Check the current authentication settings with the command: 
 
winrm get winrm/config/service/auth 

b. Enable the authentication scheme on the WinRM service with the command: 
 
winrm set winrm/config/service/auth @{<authentication 
scheme>="true"} 

For example :

To enable the Basic authentication scheme, execute the command:

winrm set winrm/config/service/auth @{Basic="true"} 

To enable the Kerberos authentication scheme, execute the command:

winrm set winrm/config/service/auth @{Kerberos="true"} 

Note: The WinRM service supports Basic authentication only for local accounts and the 
Kerberos authentication for domain users in addition to users in admin groups.

3. To allow the transfer of unencrypted data on the WinRM service, run the 
following command: 
 
winrm set winrm/config/service @{AllowUnencrypted="true"} 

4. To set the MaxEnvelopeSizekb, so that the WinRM client and server components 
interact with the WS-Management protocol, run the following command:

 
winrm set winrm/config @{MaxEnvelopeSizekb="1039440"}

Note: On some machines single vertical quotes (ASCII character 39) are required for these 
commands as shown in the following: 
winrm set winrm/config/service/auth '@{Basic="true"}' 
winrm set winrm/config/service/auth '@{Kerberos="true"}' 
winrm set winrm/config/service '@{AllowUnencrypted="true"}' 
winrm set winrm/config '@{MaxEnvelopeSizekb="1039440"}' 
To insert the single quote character, you may need to copy and paste it from another source 
such as Notepad.
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5. For Windows 2003, to gather details on HBA configuration, install the fcinfo file, 
which can be downloaded from the Microsoft website: 
 
http://www.microsoft.com

Note: You can also automatically and remotely configure the WinRM service required for 
WS-MAN data collection using Group Policies. 

For complete details on configuring WinRM, refer to “Installation and Configuration 
for Windows Remote Management” at http://msdn.microsoft.com.

Configure Kerberos authentication
For successful Kerberos authentication across domains, follow the steps in this 
section in addition to the steps in the preceding section.

For procedural examples, please refer to EMC Community Network article “Setting 
up WS-MAN with Kerberos Authentication, on Windows Server 2008 R2.”

◆ Ensure that a trust relationship exists across domains for cross-domain Kerberos 
discovery to be successful.

◆ Associate access credentials with a domain user account

◆ Add the domain user account (not a local account) to the local Administrators 
group on the server being discovered

Note: You can meet the two requirements above by adding the domain user to the Domain 
Admins group. The Domain Admins group is automatically added to all Windows domain 
servers as part of the local Administrators group.

◆ Configure the Key Distributrion Center (KDC) name to discover hosts using 
Kerberos authentication

Configure KDC name while deploying ProSphere
Add the Domain Name Server (DNS) value for KDC to the DNS Server field and the 
domain name of KDC to the search domain field in the vApp configuration step for 
the ProSphere Application, Discovery Engine, Historical Database, and all the 
Collectors.

Configure KDC name after deploying ProSphere

Note: In vCenter if the Edit Settings option is used to put more than two IP addresses in the 
DNS field, or if during the deployment of the ProSphere appliance more than two IP addresses 
are provided, then when the appliance is rebooted, vCenter does not update DNS settings on 
the appliance. Only two DNS servers can be used for ProSphere vApp deployment.

If the DNS value for KDC is not configured while deploying ProSphere, perform the 
following:

1. Power-down the vApp.

2. Right click on individual VMs and select Edit Settings.

3. In Options > Properties, add DNS for KDC to the DNS Server field and the 
domain name of KDC to the search domain field for Kerberos authentication.

4. Power on the vApp.

These changes must be performed on all the ProSphere VMs and Collectors.
EMC ProSphere Deployment Guide34



Configure Hosts
Note: Ensure that you can correctly resolve the hostname associated with the IP address from 
ProSphere.

Configure Windows hosts and WMI
ProSphere supports discovery of Windows hosts through Windows Management 
Instrumentation (WMI). 

Note: WS-MAN is the preferred discovery mechanism for Windows 2008 and later.  
 
ProSphere will copy the INQ binary executable on Windows hosts when discovery is 
scheduled using the WMI access profile.

The following sections describe how to configure WMI to work with ProSphere.

Prerequisites for Windows Server 2003 or 2008, and Windows 2012

Note: On Windows 2012, before performing steps in this section, change network connectivity 
from public to private. Go to Control Panel. Select Network and Internet. Under Network and 
Sharing Center, click Connect to a network. On the right-hand screen, right-click Network-> 
Turn Sharing on or off. Click Yes, Turn on sharing and connect to devices. After performing 
the steps in this section, set network connectivity as preferred.

The following are prerequisites for Windows host discovery by ProSphere:

◆ Discovery must be done under the access profile of a user that is an Administrator 
or a member of the Administrators group. These credentials are entered as WMI 
credentials in ProSphere. The EMC ProSphere Administrator Guide explains how to 
create access credentials.

◆ The user account used for discovery must be permitted access to the host to be 
discovered.

◆ The user has WMI privileges. 

◆ The user has write privileges to the default Temp directory. 

On Windows 2003, the path for the default Temp directory is:

C:\Document and Settings\<user name>\local settings\Temp 

ProSphere tries to write data to the default Temp directory.

If this directory does not have write privileges, ProSphere tries to write data to 
C:\Windows\Temp.

If the C:\Windows\Temp directory does not have write privileges, ProSphere 
tries to write data to the user-configured %Temp% directory.

If the user-configured %Temp% directory does not have write privileges, the 
operation fails.

On Windows 2008, the path for the default Temp directory is:

C:\Users\<user name>\AppData\Local\Temp

ProSphere tries to write data to the default Temp directory.

If this directory does not have write privileges, ProSphere tries to write data to 
C:\Windows\Temp.
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If the C:\Windows\Temp directory does not have write privileges, ProSphere 
tries to write data to the user-configured %Temp% directory.

If the user-configured %Temp% directory does not have write privileges, the 
operation fails.

Note: To find the exact location of the %Temp% directory:  
Select Start->Run 
Type %Temp% 
This opens the directory.

◆ Ensure that the Visual C++ 2005 SP1 Redistributable Package is installed on the 
host. 

Note: In case the windows update option is enabled and you do not find this package on 
your system, you can download the package from http://www.microsoft.com/

◆ Ensure that the WMI and Remote Registry services are running.

Note: To ensure that the services are started: 
Select Start->Run 
Type services.msc.. 
Ensure the Windows Management Instrumentation and Remote Registry services are 
started. If they are not, right click on the services and select Start.

◆ Make appropriate registry changes on a Windows Server 2008 R2 host. The 
section “Make registry changes on a Windows Server 2008 R2 host” on page 42 
provides information on the required registry changes.

◆ For WMI, to allow access to the Root/CIMV2 namespace and all subnamespaces 
the following permissions must be set:

• Execute Methods

• Full Write

• Partial Write

• Enable Account

• Remote Enable

• Read Security

The section “Add a user with the necessary WMI permissions” on page 38 
provides information on how to set the necessary permissions.

◆ Microsoft Distributed Object Component Model (DCOM) communication is 
enabled on the server to be discovered.

The section “Enable DCOM” on page 38 provides information on how to 
configure DCOM on port 135.

◆ The host firewall is properly configured to permit DCOM on port 135. 

The section “Add a firewall exception to open Dynamic RPC ports” on page 39 
provides information on how to configure DCOM on port 135.

◆ ProSphere must be using Windows credentials with remote DCOM permissions 
and WMI permissions.
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Disable UAC on Windows 2008 SP2
1. Open a command prompt and type msconfig.

2. Select the tools tab, scroll down select Disable UAC, and select Launch.

3. Make the desired changes in the dialog box to disable UAC.

4. Confirm the success message.

5. Reboot the host.

Disable UAC on Windows 2008 R2
1. Open a command prompt and type msconfig.

2. Select the tools tab, then select Change UAC Settings.

3. Select Launch.

4. Make the desired changes in the dialog box to disable UAC.

5. Reboot the host.

Add a user with the necessary remote DCOM permissions
To configure a DCOM-enabled user account on a Windows server host:

1. Log on to the server as a local or domain user who has full read/write 
permissions to the %Temp% directory.

2. Click the Windows Start button and then select Run.

3. Type dcomcnfg.

4. Expand Component Services in the Console Root tree view, and then expand 
Computers.

5. Right-click My Computer from the expanded Computers tree view, and then 
select Properties.

6. Click Default Properties.

7. Select Enable Distributed COM on this computer.

8. Click COM Security.

9. Click Edit Limits in the Launch and Activation Permissions area.

10. Ensure the Administrators group or the username you require is in the list of 
Group and user names. 

In case the Administrators group or the username is not present in the list:

a. Click Add.

b. Type the Administrator group or username in the Enter the object names to 
select field. The username you add must have full permissions to the 
%Temp% directory.

c. Click OK.

11. In the Permissions for Administrators area, select the Remote Launch and 
Remote Activation boxes to provide the user with these permissions and then 
click OK.
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12. Click OK to close the My Computer Properties and Component Services dialog 
boxes.

Enable DCOM
On the host to be discovered, verify that the following registry key value is set to Y:

HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\Ole ->EnableDCOM

Add a user with the necessary WMI permissions
To set WMI privileges for a Windows user account:

1. Log on to the server as a local or domain user.

2. Click the Windows Start button and then select Run.

3. Type WMIMGMT.MSC.

4. Right-click on WMI Control (Local) and then select Properties.

5. Click the Security tab.

6. Select the Root > CIMV2 namespace and then click Security.

7. Select the user account or group that has the DCOM permission setting required 
for discovery, as selected in “Add a user with the necessary remote DCOM 
permissions” on page 37

In case the user account or group name is not listed, step 10 on page 37 provides 
instructions to add the required user account or group.

8. Ensure that all the permissions are enabled in the Permissions for Administrators 
area.

9. Click Apply and then OK.

10. Click OK.

11. Close the Windows Management Infrastructure (WMI) dialog box.

Configure dynamic RPC ports

Note: This procedure is applicable to both Windows Server 2003 and Windows Server 2008 and 
is required only when the firewall is enabled and all the dynamic RPC ports traffic is blocked in 
the customer environment.

To configure dynamic RPC ports:

1. Log on to the server as a local or domain user.

2. Click the Windows Start button, then select Run.

3. Type regedt32.exe.

4. Expand the following registry key path: 
 
HKEY_LOCAL_MACHINE\Software\Microsoft\Rpc

5. Create subkeys under Rpc by right-clicking on Rpc and then selecting New > Key.

6. Set the new key name to Internet.

7. Right-click the Internet key and select New > Multi-String Value. Set the new 
value to Ports.

8. Right-click on the Ports key and select Modify. 

9. Type in the dynamic RPC ports as 5000-5100.
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10. Right-click the Internet key, select New > String Value, and assign the name 
PortsInternetAvailable.

11. Right-click PortsInternetAvailable and select Modify.

12. Type the letter Y in the Value Data field.

13. Right-click the Internet key, select New > String Value, and assign the name 
UseInternetPorts.

14. Right-click UseInternetPorts and select Modify. 

15. Type the letter Y in the Value Data field.

16. Exit the Registry Editor. 

17. Restart the host to activate these dynamic port changes.

Note: In ProSphere, if you configure a single port (for example: port 135) and try to discover 
hosts, multiple threads from topology and performance data collection collide on that host 
resulting in discovery errors. Therefore, a range of ports is required for discovery to be 
successful. It is recommended that you have 100 open ports to support the metrics claimed in 
EMC ProSphere Performance and Scalability Guidelines. If you have more than the typical number 
of applications on a host, you may need to open more ports.

Add a firewall exception to open Dynamic RPC ports
If a firewall is enabled, you need to add firewall exceptions that opens port 135 and 
the dynamic RPC ports. 

The EMC ProSphere Security Configuration Guide lists ports that ProSphere requires to 
be open and listening, and lists port assignments.

On Windows Server 2008, if you have the default Windows 2008 firewall software 
then add the following exception rules to allow the WMI traffic.

Inbound firewall exception rule for dynamic RPC ports

To create an inbound firewall exception rule ProSphere-Dynamic-RPC-ports:

1. Click Start > Administrative tools > Windows firewall with Advanced Security.

2. Select Inbound Rules in the left hand navigation tree.

3. Right-click Inbound Rules and click on New Rule.

4. Select Rule Type as Custom and click Next.

5. Select This program path in the Program section, and type 
%SystemRoot%\System32\dllhost.exe as a path for dllhost.exe

6. Ensure Services is set as default (all programs and services only) in the Program 
section, and click Next.

7. Select TCP for Protocol Type, Dynamic RPC for Local Port, All Ports for Remote 
Port in the Protocol and Ports section, and click Next.

8. Ensure the Scope and Action properties section is set as default and click Next.

9. Enable Domain, Private, and Public in Profile section, and click Next.

10. Set Name as ProSphere-Dynamic-RPC-ports and click Finish.
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Note: You can also type the following command at a command prompt to create the above rule: 
netsh advfirewall firewall add rule name="ProSphere-Dynamic-RPC-ports" 
dir=in action=allow program="%SystemRoot%\System32\dllhost.exe" 
protocol=TCP localport=RPC profile=public,private,domain

Inbound firewall exception rule for port 135

To create an inbound exception rule for the port 135 ProSphere-WMI-DCOM-in:

1. Click Start > Administrative tools (Control Panel)> Windows firewall with 
Advanced Security.

2. Select Inbound Rules in the left hand navigation tree.

3. Right-click Inbound Rules and click on New Rule.

4. Select Rule Type as Custom and click Next.

5. Select This program path in the Program section, and type 
%SystemRoot%\System32\svchost.exe as a path for svchost.exe

6. Select Services by clicking on Customize button in the Program section.

7. Highlight Apply to this Service, select Remote Procedure Call(RPC) as the 
service, click OK and click Next.

8. Select TCP for Protocol Type, RPC Endpoint Mapper for Local Port, All Ports for 
Remote Port in the Protocol and Ports section, and click Next.

9. Ensure the Scope and Action properties section is set as default and click Next.

10. Enable Domain, Private, and Public in Profile section, and click Next.

11. Set Name as ProSphere-WMI-DCOM-in and click Finish.

Note: You can also type the following command at a command prompt to create the above rule: 
netsh advfirewall firewall add rule name="ProSphere-WMI-DCOM-in" 
dir=in action=allow program="%SystemRoot%\System32\svchost.exe" 
service=RpcSs protocol=TCP localport=RPC-EPMap 
profile=public,private,domain

Inbound firewall exception rule to allow asynchronous WMI traffic

To create an inbound firewall exception rule ProSphere-WMI-Async-in:

1. Click Start > Administrative Tools > Windows Firewall with Advanced 
Security.

2. Select Inbound Rules in the left hand navigation tree.

3. Right-click Inbound Rules and click on New Rule.

4. Select Rule Type as Custom and click Next.

5. Select This program path in the Program section, and type 
%SystemRoot%\System32\wbem\unsecapp.exe as a path for unsecapp.exe

6. Ensure Services is set as default (all programs and services only) in the Program 
section, and click Next.

7. Select TCP for Protocol Type, Dynamic RPC for Local Port, All Ports for Remote 
Port in the Protocol and Ports section, and click Next. 

8. Ensure the Scope and Action properties section is set as default and click Next.
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9. Select Profile as appropriate for the network, in the Profile section, and click 
Next.

10. Set Name as ProSphere-WMI-Async-in and click Finish.

Note: You can also type the following command at a command prompt to create the above rule:  
netsh advfirewall firewall add rule name="Prosphere-WMI-Async-in" dir=in action=allow 
program="%SystemRoot%\System32\wbem\unsecapp.exe" protocol=TCP localport=RPC 
profile=public,private,domain

Inbound firewall exception rule called Prosphere-WMI-in

To create an inbound firewall exception rule ProSphere-WMI-in:

1. Click Start > Administrative Tools > Windows Firewall with Advanced 
Security.

2. Select Inbound Rules in the left hand navigation tree.

3. Right-click Inbound Rules and click on New Rule.

4. Select Rule Type as Custom and click Next.

5. Select This program path in the Program section, and type 
%SystemRoot%\System32\svchost.exe as a path for svchost.exe

6. Select Services by clicking on Customize button in the Program section.

7. Highlight Apply to this service, select Windows Management Instrumentation 
as the service, click OK and click Next. 

8. Select TCP for Protocol Type, Dynamic RPC for Local Port, and All Ports for 
Remote Port in the Protocol and Ports section, and click Next.

9. Ensure the Scope and Action properties section is set as default and click Next.

10. Select Profile as appropriate for the network, in the Profile section, and click 
Next.

11. Set Name as ProSphere-WMI-in and click Finish.

Note: You can also type the following command at a command prompt to create the above rule: 
netsh advfirewall firewall add rule name=" Prosphere-WMI-in" dir=in action=allow 
program="%SystemRoot%\System32\svchost.exe" service=Winmgmt protocol=TCP 
localport=RPC profile=public,private,domain

For Windows 2003, if you are using a third-party firewall software or windows 
firewall software, then you need to configure the firewall exceptions to allow the 
traffic for port 135 and the dynamic RPC ports.

The port 135 must be open to accept the incoming remote connection to the Service 
Control Manager (SCM), which provides RPC-based services for DCOM. The port 
allows the client to locate a DCOM service.

Note: This procedure is required only if the port 135 is locked in the customer environment.

To open the DCOM port:

1. Click Start, and then click Control Panel.

2. Double-click Windows Firewall, and then click the Exceptions tab.

3. Click Add Port. 
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4. Type DCOM_TCP135 in the Name field, and 135 in the Port number field.

5. Click TCP, and then click OK.

6. Click OK and close the Control Panel window.

Note: You can also type the following command at a command prompt to open a port:  
netsh firewall add portopening protocol=tcp port=135 name=DCOM_TCP135 
mode=ENABLE

Firewall exception rule for dllhost.exe

To create a firewall exception for dllhost.exe:

1. Click Start > Control Panel > Windows firewall.

2. Select Exceptions tab and click Add Program.

3. Click Browse and select dllhost.exe from the path 
%SystemRoot%\System32\dllhost.exe.

Note: You can also type the following command at a command prompt to create the above rule: 
netsh firewall add allowedprogram program="%systemRoot%\system32\dllhost.exe" 
name="dllhost.exe" mode=ENABLE

Make registry changes on a Windows Server 2008 R2 host 
The following DCOM-related host registry changes are required to discover a 
Windows Server 2008 R2 host.

1. Run the regedit command to open the Registry Editor and navigate to the key 
HKEY_CLASSES_ROOT\CLSID\76a64158-cb41-11d1-8b02-00600806d9b6, 
which is for the WBEM Scripting Locator.

2. Right-click and select Permissions.

3. Choose the Administrators group and assign Full Control.

4. Click Advanced.

5. Click Owner, and change the owner to Administrators group.

6. Click Apply and OK.

7. Click OK and then exit the Registry Editor.

Configure UNIX and Linux hosts
The following sections describe how to configure Linux and UNIX hosts for 
ProSphere discovery and performance data collection.

Note: ProSphere will copy the INQ binary executable on Unix and Linux hosts when discovery 
is scheduled using the SSH access profile.
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Discovery requirements
For discovery, ProSphere requires user credentials for Secure Shell (SSH) access to 
UNIX and Linux hosts. The user account used for discovery must be permitted access 
to the host to be discovered. These credentials are entered as SSH credentials in 
ProSphere. The EMC ProSphere Administrator Guide explains how to create access 
credentials.

Run with root privileges

One important requirement for Linux/UNIX host discovery is the ability for some 
discovery commands to run as root user. This can be achieved through tools or 
commands, such as sudo.

Use sudo for host discovery
Linux and UNIX host discovery requires use of the sudo command to elevate the 
discovery mechanism to root privilege for select commands. The sudo command 
enables you to:

◆ Temporarily elevate user credentials to root for specific commands that are 
configured in the sudoers file.

◆ Log on to a Linux or UNIX machine as a non-root user.

◆ Run SCSI commands to discover storage-related information for the host.

The following configuration must be set on the host when using sudo user for host 
discovery. 

◆ The path of sudo command must be included in environment variable $PATH for 
the sudo user. The variable $PATH can be set either in /etc/environment or 
/etc/default/login or any other OS specific file.

◆ The paths of OS commands must be included in environment variable $PATH for 
sudo user. These paths are different for different operating systems.

Usually, most of the command files are located at the following locations by 
default:

/usr/local/sbin:/usr/local/bin:/sbin:/bin:/usr/sbin:/usr/bin

These paths should be included in $PATH variable.

◆ To test whether the path is correctly set, log in as sudo user, and run which sudo 
or sudo. 

◆ The sudoers file must be available. By default, it is available in /etc or 
/opt/sfw/etc/ or /usr/local/etc/sudoers.

◆ The sudo user should have root privilege to run the following commands on a 
given host for resource discovery:

• /tmp/nl_dwd/inq

• <path of fcinfo command>/fcinfo

• <path of powermt command>/powermt

• <path of dmidecode command>/dmidecode

• <path of sar command>/sar (for collection of path performance data on 
AIX and HP-UX hosts)
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Note: To allow a non-privileged ProSphere user to use the sar utility as root user, include the 
following line in the sudoers file:  
srm ALL=(ALL) nopasswd: <path of sar command>/sar 
For example:  
srm ALL=(ALL) nopasswd: /usr/local/sbin/sar

Note: Figure 2 on page 44 provides an example of additional, required sudoers file content. 
It is recommended that you do not edit the sudoers file with any editor other than visudo. The 
permissions for a valid sudoers file must be set to 440.

login as: cmguser
Password:*****
#sudo
usage: sudo -h | -K | -k | -L | -V
...
#which sudo
/usr/local/bin/sudo
#ls -l /etc/sudoers
-r--r-----   1 root     root         923 Dec 13 05:36 /etc/sudoers

login as: root
Password:*****
#visudo sudoers

# sudoers file.
#
# This file MUST be edited with the 'visudo' command as root.
#
# See the sudoers man page for the details on how to write a sudoers file.
#
# Host alias specification
# User alias specification

User_Alias CMGU=cmguser
# Cmnd alias specification

Cmnd_Alias CMGEMC=/tmp/nl_dwd/inq,<path of powermt command>/powermt,<path 
of dmidecode command>/dmidecode,<path of fcinfo command>/fcinfo, <path of 
sar command>/sar

# Defaults specification
# User privilege specification

root ALL=(ALL) ALL
CMGU ALL=NOPASSWD:CMGEMC

# Uncomment to allow people in group wheel to run all commands
# %wheel ALL=(ALL) ALL
# Same thing without a password
# %wheel ALL=(ALL) NOPASSWD: ALL
# Samples
# %users ALL=/sbin/mount /cdrom,/sbin/umount /cdrom
# %users localhost=/sbin/shutdown -h now
#cmguser ALL=(ALL) NOPASSWD: ALL

login as: cmguser
Password:*****
#sudo fcinfo hba-port
HBA Port WWN: 10000000c9702593 
…
#ls /tmp/nl_dwd/inq
/tmp/nl_dwd/inq
#sudo /tmp/nl_dwd/inq -mapinfo

Figure 2 Sample sudoers file content for Linux/UNIX host discovery
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SSH key based authentication
ProSphere uses SSH private/public key based authentication that enables you to 
discover UNIX hosts with a private key. A public key needs to be present on all the 
UNIX hosts that are to be discovered using the private key. 

You can choose any key generation tool to generate a valid public/private key pair.

These steps describe the procedure to generate a public and private key pair for 
UNIX hosts using the ssh-keygen tool.

1. For UNIX hosts outside of ProSphere, generate a public and private key pair 
using the command: 

ssh-keygen -t rsa -f  <location_of_the_private_key/name_of_ 
private_key_file> -N "passphrase"

Note: Leave the passphrase blank  if you do not choose to encrypt. 
 
For example: ssh-keygen -t rsa -f /root/.ssh/id_rsa -N””

2. Ensure that the public and private key pair that is generated has the following 
permissions:

chmod 600 /root/.ssh/id_rsa 
chmod 644 /root/.ssh/id_rsa.pub 

Note: The private key file is id_rsa, the public key file is id_rsa.pub.

3. To make the key pair functional, append the public key to 
/root/.ssh/authorized_keys in the target UNIX host using the following 
command:

cat <location_of_the_private_key/name_of_private_key_file> >>  
/root/.ssh/authorized_keys 

For example:  
cat /root/.ssh/id_rsa.pub >> /root/.ssh/authorized_keys

4. Copy the private key (that is, /root/.ssh/id_rsa) to the ProSphere Discovery 
Engine:

a. Copy the private key to any location on the machine from which ProSphere is 
accessed.
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b. Use the Import Private key button on the Create Access Credentials dialog 
box to get the key from the machine where ProSphere is accessed and copy the 
key to the ProSphere Application. The following graphic illustrates the Import 
Private key button.

Collect performance data
For collection of path performance data, specific software (depending on host 
Operating System) must be running on the host. 

◆ Solaris — iostat

◆ Linux (RedHat and SuSE) — The iostat package version 5.0.5 must be installed on 
the Linux host for successful path performance collection. If the package is not 
installed, path performance collection fails with the error “Failed to discover 
performance metrics.”

◆ AIX — sar

◆ HP-UX — sar

◆ Windows 2000 and later — The Windows Management Instrumentation (WMI) 
service must be enabled and running. 
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Consult the relevant manpages and user documentation for installation and 
configuration instructions for these tools.

Contact your UNIX vendor for information about downloading and installing their 
iostat (or sar) package.

Prepare for discovery of VMware guests
A VMware guest is the operating system on a virtual machine.

For ProSphere to discover a host where a VMware guest resides  (that is, discover a 
virtual machine rather than a physical host), VMware tools is required.  Work with 
your VMware admin to have VMware tools installed on VMware guests.

If VMware Tools are not installed on a VMware guest, ProSphere cannot discover the 
virtual machine where the VMWare guest resides.

Prepare for discovery of VMware infrastructure
The virtual infrastructure of VMware environments is discovered by ProSphere from 
vSphere vCenter using the Virtual Infrastructure (VI) API. This Web Services API is 
hosted on vCenter servers and can be accessed by ProSphere for resource discovery. 
For more information about this service interface, refer to the VMware vSphere Web 
Services Documentation at:

http://www.vmware.com

Discovery requirements
For virtual infrastructure discovery, ProSphere requires:

◆ Assignment of individual ESX credentials or assignment of VirtualCenter 
credentials. In either case, Read-only permissions must be included, with the 
addition of Browse Datastore and StorageViews—View permissions. These 
credentials are entered as VMware Infrastructure credentials in ProSphere. The 
EMC ProSphere Administrator Guide provides instructions for creating discovery 
access credentials.

◆ Unblocked access to the IP address of the Web Services interface on all VMware 
ESX and VirtualCenter servers to discover.
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Configure Storage 
Systems

This chapter provides configuration instructions for array data providers used by 
EMC ProSphere, such as SMI-S providers, to support resource discovery and data 
collection. 

This chapter includes the following sections:

◆ Configure the EMC SMI-S Provider ...........................................................................  50
◆ Configure the EMC Control Station for NAS............................................................  53
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Configure the EMC SMI-S Provider 
The EMC SMI-S Provider provides partners and other product groups with an 
industry-standard SNIA interface to EMC arrays, which produces faster solution 
development. Ultimately, it ensures interoperability and simplified management of 
customers' network environments. EMC SMI-S Provider supports the SNIA Storage 
Management Initiative (SMI), an ANSI standard for storage management. 

The SMI strives to ensure consistent data by providing a unified interface to the many 
storage objects that must be managed in a storage environment. This enables 
application developers to focus on a single standard interface for the development of 
management tools.

The EMC SMI-S Provider has been paired with the EMC Common Object Manager 
(ECOM) to provide an SMI-compliant interface for EMC Symmetrix® and 
VNX™/CLARiiON® arrays. ProSphere collects resource and performance data for 
EMC Symmetrix, VNX and CLARiiON storage arrays using the EMC SMI-S 
Provider..

Requirements for discovery data collection
To discover supported Symmetrix, VNX, and CLARiiON storage devices and collect 
resource data from them in ProSphere, the following requirements must be met:

◆ A host that manages and monitors a Symmetrix array needs six dedicated 
gatekeepers from each Symmetrix array.

◆ A supported version of the EMC SMI-S Provider for the array must be installed 
on a host that has FC connectivity to Symmetrix arrays and IP connectivity to the 
CLARiiON/VNX arrays 

Note: To be discovered, a Symmetrix array must have connectivity to the host where the SMI-S 
Provider is installed. Only FC connected arrays in a remote replication configuration are 
discovered in ProSphere, so multiple SMI-S Providers are needed to discover all the arrays. 
Refer to the SMI-S release notes to determine scalability limitations. Therefore, you should 
install SMI-S Providers on hosts in such a way that each array has connectivity from at least 
one SMI-S Provider host.

The EMC SMI-S Provider is available for download from the EMC Online Support 
site (support.emc.com) and may optionally be provided by EMC on CD-ROM. 
Installation instructions can be downloaded with the software in the EMC SMI-S 
Provider Release Notes.

Note: When installing the EMC SMI-S Provider, EMC Solutions Enabler is also installed. Any 
previous version of EMC Solutions Enabler will be uninstalled, and the new version of EMC 
Solutions Enabler will be installed. You may need to install the additional EMC Solutions 
Enabler daemons that are not included in the basic SMI-S Provider /EMC Solutions Enabler 
installation. 

Note: Only one version of EMC SMI-S Provider and EMC Solutions Enabler can be installed on 
the same host.

◆ The EMC SMI-S Provider host must be accessible by ProSphere in the TCP/IP 
network. The host IP address, access port, username, password, and namespace 
for the provider must be known to enter these as access credentials in ProSphere. 
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These credentials are entered as SMI-S credentials. The EMC ProSphere 
Administrator Guide provides instructions for creating discovery access 
credentials.

◆ VNX/CLARiiON SPA IP address or FQDN, VNX/CLARiiON SPB IP address or 
FQDN, and VNX/CLARiiON username and password must be known.

Requirements for performance data collection
EMC Unisphere for VMAX must be installed in order to display performance data for 
the “Array FE Directors - % busy” metric as well as handle Symmetrix Performance 
Analyzer alerts in ProSphere. 

“Integrate ProSphere with Unisphere for VMAX” on page 105 provides configuration 
details.

In vCenter, the security level must be set to 2 or 3 to collect performance data.

Configure the provider
The EMC SMI Provider must be configured to access the arrays before ProSphere can 
discover the arrays. The EMC SMI-S Provider release notes contain instructions for 
setting up the Provider.

Verify the setup of the EMC SMI-S Provider
◆ To verify that the EMC SMI-S Provider is correctly set up, use the 

TestSmiProvider tool that is installed with the Provider on the provider host. 

◆ ProSphere array discovery requires the IP address of the EMC SMI Provider host, 
SMI Access Credentials that include the EMC SMI Provider user/password 
(default credentials are user = “admin”, password = “#1Password”), SMI 
provider port #, and SSL Enabled setting.  

Note: The EMC SMI Provider user/password is not the same as the array credentials 
previously mentioned for VNX/CLARiiON. 

The connection to the EMC SMI-S Provider can be validated using the Discovery 
Job status information.  Essentially, if arrays are detected then the SMI Access 
Credentials are correct.  If arrays are not detected, then check the Discovery Job 
status information for errors (usually the provider is either down, the provider 
user/password is incorrect, the incorrect port was specified, or the SSL enabled 
setting is incorrect). To sanity check these settings, go to the EMC SMI Provider 
host, verify that the provider is running, and use the TestSmiProvider application 
to establish a connection to the Provider using the same information supplied in 
the access credentials.

◆ For VMAX/Symmetrix arrays, it is important to keep in mind that ProSphere 
only supports VMAX/Symmetrix arrays that are fibre-attached to the EMC SMI-S 
Provider host.  This is known as a “local” connection to the provider.  
VMAX/Symmetrix arrays that are “remote” attached to the EMC SMI-S Provider 
through other intermediate arrays using RDF connections are excluded from 
discovery by ProSphere. The TestSmiProvider Display Version ("dv") command 
will show which Symmetrix and Clariion arrays are connected to the provider 
and whether they are local or remote. 
 
For VNX/CLARiiON, this means that the IP addresses for Service Processor A 
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and Service Processor B, as well as a “username and password of the CLARiiON 
or VNX array that is of administrator-level privilege with global scope” (quoted 
from the EMC SMI-S Provider Release Notes), must be specified.

• For VNX/CLARiiON that is fibre-connected to the EMC SMI-S Provider host 
(“local” to provider):  the customer must configure the provider for in-band 
discovery of the VNX/CLARiiON as detailed in the EMC SMI-S Provider 
Release Notes.

• For VNX/CLARiiON that is TCP/IP connected to the EMC SMI-S Provider 
host (“remote” to provider):  the customer must configure the provider for 
out-of-band discovery of the VNX/CLARiiON as detailed in the EMC SMI-S 
Provider Release Notes.

Replace the EMC SMI-S provider host
Typical reasons for replacing an EMC SMI-S provider host are:

◆ You have decided to decommission the current host. 

◆ The current host does not have enough memory or cpu to manage storage arrays. 

Use this procedure:

1. Decommission the current SMI-S provider host. 

2. If you will continue to use the host for a different purpose, uninstall the EMC 
SMI-S provider from the host.

3. Install the EMC SMI-S provider on the new host and add arrays.

4. Rerun the initiation discovery job using the provider IP of the new EMC SMI-S 
Provider host.  
 
ProSphere starts using the new provider on the new host. Performance data 
collection for arrays is through the new provider as well.
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Configure the EMC Control Station for NAS
ProSphere NAS discovery requires access to Control Station with the NAS license 
enabled either for CIFS, NFS or both.  Optionally, the “snapsure” license can be 
enabled. The user can check and enable the required license through the NAS CLI or 
the Unisphere UI for Control Station. For the most recent details, refer to the NAS 
Control Station documentation. 

IMPORTANT!
Ports 7 and 443 must be open to permit a successful VNX file or Celerra discovery 
in ProSphere 2.0.

Verify NAS licenses using Control Station
The following sections explain how to verify NAS licenses with Control Station for 
different NAS models.

Verify NAS licenses for all NAS models
For all NAS models, you can verify the NAS license using the Control Station CLI.

1. Login to the NAS CLI using the username and password for the NAS 
administrator.

2. Type the command nas_license –list to display existing licenses:

Enable a NAS license
To enable the license use this command: 

nas_license  -create  nfs (or cifs, or snapsure)

Verify licenses for older NAS models
To verify licenses for older NAS models, such as Celerra Integrated:

1. Open a browser (https://<control-station-ip> ) to NAS Control Station.
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2. Click the Licenses tab.

3. View or edit settings.

Verify licenses for newer NAS models
To verify licenses for newer NAS models, such as VNX Unified:

1. Open a browser (https://<control-station-ip>) to NAS Control Station 
to view and edit license settngs.

2. Select Settings.

3. Select More Settings.
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4. Select Manage Licenses for file.

5. View or edit settings.
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Configure Switches 

This chapter provides configuration instructions for switches to support resource 
discovery and data collection in EMC ProSphere. 

The chapter includes the following sections:

◆ Configure Cisco switches.............................................................................................  58
◆ Configure Brocade SMI Agents...................................................................................  63
Configure Switches 57



Configure Switches
Configure Cisco switches
This section applies to homogeneous fabrics that contain one or more Cisco switches.

ProSphere supports two modes of SNMP communications for Cisco switches: the less 
secure SNMPv1/v2 mode and more secure SNMPv3 mode.

Perform preconfiguration tasks
Before you discover a Cisco switch or a homogeneous Cisco fabric in ProSphere:

1. Ensure all hardware (including switch model) and software is listed as supported 
in the EMC ProSphere Support Matrix.

2. Verify the TCP/IP connectivity to the switches to be discovered. Test by issuing a 
ping command to these switches.

Determine if SNMP traps are enabled. Log in to the switch and run the show 
snmp trap command, as in the following example:  

SWDevCisco8-9216i# show snmp trap

Trap type Enabled

entity : entity_mib_change Yes

entity : entity_module_status_change Yes

entity : entity_power_status_change Yes

entity : entity_module_inserted Yes

entity : entity_module_removed Yes

entity : entity_unrecognised_module Yes

entity : entity_fan_status_change Yes

entity : entity_power_out_change Yes

link : linkDown Yes

link : linkUp Yes

link : extended-linkDown Yes

link : extended-linkUp Yes

link : cieLinkDown Yes

link : cieLinkUp Yes

link : connUnitPortStatusChange Yes

link : fcTrunkIfUpNotify Yes

link : fcTrunkIfDownNotify Yes

link : delayed-link-state-change Yes

link : fcot-inserted Yes

link : fcot-removed Yes

callhome : event-notify No
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callhome : smtp-send-fail No

cfs : state-change-notif No

cfs : merge-failure No

fcdomain : dmNewPrincipalSwitchNotify No

fcdomain : dmDomainIdNotAssignedNotify No

fcdomain : dmFabricChangeNotify No

rf : redundancy_framework Yes

aaa : server-state-change No

license : notify-license-expiry Yes

license : notify-no-license-for-feature Yes

license : notify-licensefile-missing Yes

license : notify-license-expiry-warning Yes

scsi : scsi-disc-complete No

fcns : reject-reg-req No

fcns : local-entry-change No

fcns : db-full No

fcns : remote-entry-change No

rscn : rscnElsRejectReqNotify No

rscn : rscnIlsRejectReqNotify No

rscn : rscnElsRxRejectReqNotify No

rscn : rscnIlsRxRejectReqNotify No

fcs : request-reject No

fcs : discovery-complete No

fctrace : route No

zone : request-reject1 No

zone : merge-success No

zone : merge-failure No

zone : default-zone-behavior-change No

zone : unsupp-mem No

vni : virtual-interface-created No

vni : virtual-interface-removed No

vsan : vsanStatusChange No

vsan : vsanPortMembershipChange No

fspf : fspfNbrStateChangeNotify No

upgrade : UpgradeOpNotifyOnCompletion Yes
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In this example, many of the traps are not enabled. EMC recommends enabling all 
traps, unless there is a compelling reason not to do so.

3. Enable SNMP traps. Run the snmp-server enable traps command, as in the 
following example: 
 
SWDevCisco8-9216i# config terminal 
Enter configuration commands, one per line. End with CNTL/Z. 
SWDevCisco8-9216i (config)# snmp-server enable traps

4. Display the traps that are enabled. Run the show snmp trap command. The 
values in the Enabled column should be Yes.

EMC recommends that all switches in the Cisco fabric have the same SNMP  
credentials for use with ProSphere. For example, if the SNMPv1/v2 community 
setting private is used, all Cisco switches in the fabric should have the SNMPv1/v2 
private community name set with a role of network-admin. For an SNMPv3 user, the 
same SNMPv3 credentials with the role of network-admin should be set on every 
switch in the fabric.

Note: ProSphere displays the Cisco VSAN fabric as partially discovered if no community string 
was provided during its configuration.

Cisco switch discovery is initiated by pointing ProSphere discovery dialog to a seed 
switch. ProSphere discovers all switches in the fabric by obtaining the fabric members 
from the seed switch. Therefore, all Cisco switches need to have either SNMPv1/2 or 
SNMPv3 configuration set.

ProSphere discovers all the connected switches in a physical fabric.

ProSphere does not support discovery of Cisco switches over FCIP connections. To 
discover a Cisco fabric that contains FCIP connections, discover a Cisco switch on 
either side of the FCIP connection.

ProSphere does not support Cisco device aliases or Cisco enhanced device aliases.

Configure switches for SNMPv1/2
The SNMPv1/2 information you enter when performing discovery is necessary for 
ProSphere to contact the switch to obtain information. ProSphere collects data from 
the switch using the same SNMP community name. It uses SNMP port for 
communication. This is normally hard set to port 161.

1. Refer to the Cisco documentation for detailed information on configuring Cisco 
switches for SNMPv1/v2 management.

2. The Cisco switches must have an SNMPv1 community name that has read only 
privileges set on every switch in the fabric. The SNMP community selected must 
have a network-operator role.

upgrade : UpgradeJobStatusNotify Yes

feature-control : FeatureOpStatusChange No

vrrp : cVrrpNotificationNewMaster No

fdmi : cfdmiRejectRegNotify No

snmp : authentication No
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3. Log in to the switch and log in as an administrator.

4. Use the snmp-server community command to configure read-only privileges as 
shown in the next example: 
 
Cisco8-9216i# config terminal 
 
Enter configuration commands, one per line. End with CNTL/Z. 
 
Cisco8-9216i(config)# snmp-server community eccuser ro

5. To determine if an SNMPv1 community user exists, log in to the switch and run 
the command as shown in following example:

Cisco8-9216i# show snmp community

6. Set the ProSphere Discovery Engine as the SNMPv1/2 trap destination.

Configure switches for SNMPv3
This section contains guidelines on creating SNMPv3 users for discovery of and 
management of Cisco switches in ProSphere.

The SNMPv3 information you enter when performing discovery is necessary for 
ProSphere to contact the switch to obtain information. ProSphere collects data from 
the switch using SNMPv3 secure credentials. ProSphere uses the SNMP port for 
communication.ProSphere supports SNMPv3 with all the combinations of Auth 
(MD5, SHA) and Priv (AES, DES, NONE).

Note:  
EMC recommends creating the same SNMP v3 users with the same authentication and privacy 
passwords on all physical switches in the fabric. 
 
The Cisco documentation provides information on creating SNMP v3 users on Cisco MDS 
switches.

For example, to create an SNMPv3 user called ECCuser with a network-operator role, 
SHA authorization, and AES128 authentication, do the following:

1. Run the snmp-server user command as shown in following example: 
 
Cisco8-9216i# config terminal 
 
Enter configuration commands, one per line. End with CNTL/Z. 
 
Cisco8-9216i (config)#snmp-server user ECCuser network-operator 

auth sha <SHA-password> priv aes-128 <AES-password>

Community Group / Access

eccuser network-admin
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2. Confirm the new user creation by running the show snmp user command as 
shown in the following example:

SWDevCisco8-9216i# show snmp user

3. Set the ProSphere Discovery Engine as the SNMPv3 trap destination.

SNMP USERS

User Auth Priv(enforce) Groups

admin md5 no network-admin

ECCuser sha aes-128(no) network-operator

NOTIFICATION TARGET USERS (configured for sending V3 Inform)

User Auth Priv

SWDevCisco8-9216i#
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Configure Brocade SMI Agents
ProSphere discovers and manages Brocade FC switches through the Brocade SMI 
Agent; therefore, the Brocade SMI Agent must be installed and configured as a 
prerequisite to discovery of Brocade switches by ProSphere.

Brocade has incorporated their SMI Agent into the following products: 

◆ Connectrix Manager Converged Network Edition (CMCNE) and Brocade 
Network Advisor (BNA)

◆ Connectrix Manager Data Center Edition (CMDCE) and Data Center Fabric 
Manager (DCFM)

Refer to the EMC ProSphere Support Matrix to determine the versions of these Brocade 
products supported by ProSphere.  Refer to the CMCNE or CMDCE and/or Brocade 
SMI Agent documentation for installation and configuration instructions.

“CMCNE”  on page  109 explains how to integrate CMCNE with ProSphere.

In order to integrate ProSphere functions with Brocade products, you require licensed 
versions of one of the following: (1) BNA (2) CMCNE (Professional Plus or Enterprise 
Edition). The trial versions of BNA or CMCNE (Professional Plus or Enterprise 
Edition) can be used only for 75 days. The release notes for BNA, and the release 
notes for CMCNE provide detailed information on the product licensing.

You can install CMCNE with an option of either an integrated Brocade SMI Agent 
(SAN with Brocade SMI Agent) or just the Brocade SMI Agent only (headless 
installation).

Table 4 on page 63 lists the features of ProSphere supported by various versions of 
CMCNE or BNA.

Table 4 ProSphere features supported by CMCNE/BNA

CMCNE/BNA License 
type

Topology 
discoveries

Performance 
Data Collection

Alert 
Collection Launch-in-Context

Headless Installation 
(Brocade SMI Agent 
only)

Yes Yes Yes No

Valid Trial License Yes Yes Yes Yes

Fully Licensed Yes Yes Yes Yes
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Deploy ProSphere

This chapter provides instructions for the deployment of EMC ProSphere. The 
following sections detail ProSphere deployment:

◆ Deploy ProSphere with the vSphere Client...............................................................  66
◆ Deploy ProSphere with the vCloud Director ............................................................  72
◆ Next steps .......................................................................................................................  74

You can use the vSphere Client or vCloud Director to deploy ProSphere.

IMPORTANT!
EMC recommends that after the ProSphere vApp has been deployed, but before 
you power it on for the first time, you take a snapshot of the virtual machine under 
the vApp folder. Make sure the option to power on the virtual machine after 
installation is unchecked. Then power on ProSphere from the vApp folder. If 
ProSphere does not start and run correctly, you can revert back to the snapshot and 
edit the vApp properties to correct any mistyped information, then power on the 
vApp from the vApp folder. After ProSphere is running correctly, the snapshot 
should be deleted. After the vApp is powered on, changes to vApp properties are 
not supported.
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Deploy ProSphere with the vSphere Client
The deployment files for ProSphere include an .ovf file (small) and its related and 
co-located .vmdk files (large). Download these files from the EMC Online Support 
Site (support.emc.com) or another location specified by EMC. Place these files into a 
single folder in a local file share or URL location that is accessible to the vSphere 
Client. The vSphere Client downloads these files and transmits them to the ESX or 
ESXi server.

Note: A checksum error is displayed during deployment, even if one file is missing.The current 
and complete names of the .ovf and .vmdk files with the build numbers can be obtained from 
the EMC ProSphere Release Notes.

Deployment time
The overall deployment time can be significantly affected by:

◆ vSphere Client location in the network

◆ File transfer speeds

◆ Network performance in the environment

Therefore, EMC recommends that you deploy ProSphere and Collector from within a 
LAN shared by the VMware environment to save time. A vSphere Client running on 
a laptop with a small bandwidth virtual private network (VPN), may take several 
hours to deploy. However, a vSphere Client running in the same, fast local area 
network (LAN) as the VMware servers may take only a few minutes to deploy.

Deploy ProSphere

Note: Repeat this procedure for each ProSphere instance that you want to deploy.

1. Open the vSphere Client and connect to the vCenter server managing the 
VMware environment.

2. Select File > Deploy OVF Template, as shown in the figure.

Note: Online help is available at each step of the Deploy OVF Template dialog box in the 
vSphere Client. But this help is not specific to ProSphere. Consult your VMware administrator 
if you are uncertain about any of these steps. For example, you may be uncertain about 
inventory location to select and so on.
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3. In the Source step, browse to a file path or type an URL for the 
ProSphere-2.0.x.x.xxx.ovf file. Click Next.

4. In the OVF Template Details step, review the details of the loaded .ovf file. Click 
Next.

5. In the End User License Agreement step, review the product license agreement, 
then click Accept followed by Next.

6. In the Name and Location step, type a unique Name (for example, Local 
ProSphere deployment) and specify an Inventory Location in the VMware 
environment for the ProSphere vApp and its virtual machines. Click Next.

7. In the Host/Cluster step, select a choice (cluster, host, or both) on which the 
ProSphere vApp will run. Click Next.

8. In the Resource Pool step, select a resource pool (associated with the previously 
selected cluster or host) in which the ProSphere vApp will run. This step is 
required only if a resource pool has been predefined. Click Next.

9. In the data store step, select a data store to hold the virtual machine images for 
ProSphere. If the Thick disk format is selected, the data store should have a 
minimum 600 GB of space available. Click Next.

10. In the Disk Format step, for some data stores you are required to select the 
storage space provisioning method for the virtual machine. 

Example options include: Thin provisioned format (expansion of available storage for the virtual machine 
on demand) for newer data store file systems.

Thick provisioned format (virtual machine storage is allocated and reserved as a 
block). 

Click Next.

11. In the Network Mapping step, select a destination network for each of the virtual 
machines in ProSphere. 
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The vSphere Client may display the warning “Multiple source networks are 
mapped to the host network” if multiple virtual machines are mapped to the 
same destination network. Ignore this message. 

Note: In the VMware environment, each selected destination network must have an IP 
Pool associated with it.

Click Next.

12. In the Properties step, specify the required configuration fields. The description 
of property appears in red if the required value is missing or incorrect from the 
dialog box. The properties to set are the following.

Note: Ensure you specify only the relevant DNS and search domains.

ProSphere Setting

Timezone setting Server timezone to set on the Linux virtual machines 
deployed as part of ProSphere.

ProSphere Application Settings

ProSphere Application Hostname Hostname (FQDN) to assign to the ProSphere 
Application virtual machine (for example, 
ProSphere.abc.mycompany.com)

ProSphere Application IP Address IP address to assign to the ProSphere Application 
virtual machine. This IP address must be registered 
with the appropriate domain name servers and 
resolve for a reverse DNS lookup.

ProSphere Application Gateway Subnet gateway for hosts in the network.

ProSphere Application DNS Servers Comma-separated list of domain name servers 
(DNS) available in the network selected for the 
ProSphere Application and Key Distributrion Center 
(KDC).

Enter at most two IP addresses. In vCenter if the Edit 
Settings option is used to put more than two IP 
addresses in the DNS field, or if during the 
deployment of the ProSphere appliance more than 
two IP addresses are provided, then when the 
appliance is rebooted, vCenter does not update DNS 
settings on the appliance. 

ProSphere Application Netmask Netmask applied to IP addresses in the network.

ProSphere Application Search Domain(s). Space-delimited list of domains used in the network 
selected and the domain name for KDC.

Discovery Engine Settings

Discovery Engine Hostname Hostname to assign to the Discovery Engine (for 
example, ProSphere-discovery050).
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Click Next.

13. In the Ready to Complete step, review the list of properties that you specified for 
ProSphere deployment. If you need to change a value, click Back to return to 
change the previous steps. Click Finish to start the deployment. A status bar is 
displayed in the vSphere Client, showing the deployment progress. 

Wait for the Deployment Completed Successfully dialog box to appear.

14. Click Close to close the dialog box.

 IP Address IP address to assign to the Discovery Engine if a fixed 
IP address scheme is in use. This IP address must be 
registered with the appropriate domain name servers 
and resolve for a reverse DNS lookup.

Discovery Engine Netmask Netmask applied to IP addresses in the network.

Discovery Engine Gateway Subnet gateway for hosts in the network.

Discovery Engine DNS Servers Comma-separated list of domain name servers 
(DNS) available in the network selected and the DNS 
for KDC.

Enter at most two IP addresses. 

Discovery Engine Search Domain(s) Space-delimited list of domains used in the network 
selected and the domain name for KDC.

Note: Be sure to enter a value. Otherwise, when 
collecting host data DNS resolution fails and hosts 
discovered on the affected element managers will not 
appear in the Objects List.

Historical Database Settings

Historical Database Hostname Desired network name for the virtual host on which 
the database will be deployed.

Historical Database IP Address IP address to be used for access to the database 
virtual host if a fixed IP address scheme is in use. 
This IP address must be registered with the 
appropriate domain name servers and resolve for a 
reverse DNS lookup.

Historical Database Netmask Netmask applied to IP addresses in the network.

Historical Database Gateway Subnet gateway for hosts in the network.

Historical Database DNS Servers Comma-separated list of domain name servers 
(DNS) available in the network selected and the DNS 
for KDC.

Enter at most two IP addresses. 

Historical Database Search Domain(s) Space-delimited list of domains used in the network 
selected and the domain name for KDC.
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15. In the vSphere Client, navigate to the Hosts & Clusters view. 

a. Expand the tree in the left panel of this view.

b. Locate the cluster and host that you selected for ProSphere during 
deployment. You will see three new virtual machines:

– Historical Database
– Discovery Engine
– ProSphere Application under the name of the vApp (for example, Local 

ProSphere deployment). 
16. Start ProSphere manually after deployment. To start ProSphere in the vSphere 

Client:

a. Right-click the vApp name you assigned during deployment (for example, 
Local ProSphere deployment).

b. Select Power On, as shown in the figure. vSphere Client will display the 
power on status in the Recent Tasks bar at the bottom of the client. 

Wait until all virtual machines have started and the Status of the Start vApp 
task for the vApp name (for example, Local ProSphere deployment) under 
the Recent Tasks view is listed as Completed before proceeding.

Note: The first time the database appliance is started, it might take a while to build the required 
tables and perform other initialization steps.

You are now ready to start using ProSphere through its Web-based Console. 

Note: If it is necessary to remove the ProSphere vApp and its dependent virtual machine from 
your VMware environment, follow the procedures recommended by your organization.
EMC ProSphere Deployment Guide70



Deploy ProSphere
Deploy ProSphere with the vCloud Director
The deployment files for ProSphere include an .ovf file (small) and its related and 
co-located .vmdk files (large). Download these files from the EMC Online Support 
Site (support.emc.com) or another location specified by EMC. Place these files into a 
single folder in a local file share or URL location that is accessible to the vCloud 
Director.

Note: A checksum error is displayed during deployment, even if one file is missing. The 
current and complete names of the .ovf and .vmdk files with the build numbers can be 
obtained from the EMC ProSphere Release Notes.

Note: ProSphere only supports vCloud Director 5.1 or later.

Deployment time
The overall deployment time can be significantly affected by:

◆ The latency between the vCloud Director server and the share location in the 
network

◆ File transfer speeds

◆ Network performance in the environment

Therefore, to save time EMC recommends that you deploy ProSphere, and any 
Collectors or Secondary ProSphere Application, from within a LAN shared by the 
VMware environment. If you connect to vCloud Director from a browser session on a 
laptop across a small bandwidth virtual private network (VPN), it may take several 
hours to upload the vApp template. However, a vCloud Director server session 
launched from a browser running in the same, fast local area network (LAN) as the 
vCloud Director may take only a few minutes to upload.

Deployment procedure
Deploying ProSphere using the vCloud Director includes the following procedures:

◆ “Create a vCloud catalog”  on page  72

◆ “Upload deployment files to the catalog”  on page  72

◆ “Deploy the ProSphere vApp from the vApp template”  on page  73

Create a vCloud catalog
1. Go to the Catalogs tab. 

2. Click the plus (+) button 

3. Type a name for the catalog.

4. If you want to share the catalog with others in your organization, click Next. 
Otherwise, click Finish.

Upload deployment files to the catalog
1. In the Catalogs tab, select the catalog you created.

2. Select the Media tab.
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3. Click on the wheel icon to bring up an option menu then select Upload.This 
displays the Upload Media dialog box.

4. Click Browse and select the ProSphere.ovf file. After uploading, the files will be 
stored as a vApp Template. 

5. Enter a name for the vApp Template in the Name field.

6. Enter a description for the vApp Template (such as ProSphere vApp).

7. Click Upload. A progress screen displays the progress of the upload operation.

Note: The progress screen does not appear if popup blockers is enabled in your web browser.

8. When the upload operation is completed, click Clear.

Deploy the ProSphere vApp from the vApp template
1. Click the My Cloud tab. 

2. Left-click the plus (+) button to display the Add vApp from Catalog dialog box.

3. Select the template and click Next.

4. Read and accept EULA and click Next.

5. Type a name for the vApp.

6. Type a description for the vApp, and click Next.

7. Select the virtual datacenter from the dropdown list.

8. Select Static-Manual as the IP assignment, and click Next.

9. Enter network parameters for each virtual machine.The following list contains 
sample data:

a. IP Range: xx.xxx.xx. 01-03

b. Hostname Range: xxxxx01-03

c. Netmask: xxx.xxx.xxx.0

d. Gateway: xx.xxx.xx.x

e. DNS: xx.xxx.xx.xx, yy.yyy.yy.yy

Note: Enter at most two IP addresses in the DNS field. 

f. DNS Search Path domain: com test.test;.com test.corp.com,test.com

Note: Be sure to enter a value. Otherwise, when collecting host data DNS resolution fails and 
hosts discovered on the affected element managers will not appear in the Objects List.

10. Enter the following information for each virtual machine displayed:

a. ProSphere Application IP address

b. ProSphere Application search domain

c. ProSphere Application hostname

d. ProSphere Application DNS servers

Note: Enter at most two IP addresses for DNS servers. 
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e. ProSphere Application gateway

f. ProSphere Application netmask

11. Select a time zone. Click Next. 
The Ready to Complete dialog appears. Check that the information is correct.

12. Click Finish. The vApp is listed in the My Cloud window.

13. When deployment has completed successfully:

a. In the My Cloud window, select the vApp.

b. Click Start.

14. If you need to modify the default lease settings of seven days, follow these steps:

a. Right-click the vApp and navigate to Properties > General > Lease.

b. Select the lease settings recommended by your vCloud administrator.

c. Follow the wizard instructions and click Finish.

Modify action and delay settings
1. In the My Cloud window, click the vApp tab, right-click the ProSphere vApp and 

select Properties.

2. Click the Starting and Stopping VMs tab.

3. Change the Boot Delay (seconds) value to 120.

4. Change the Stop Delay (seconds) value to 600.

5. Change the Stop Action to Shutdown.

Next steps
Congratulations! You now have deployed ProSphere vApp. You can proceed to these 
next steps:

1. “Deploy Collectors” on page 85.

2. “Deploy Secondary ProSphere Application” on page 93

3. “Synchronize time zones and system times” on page 102 to verify the deployment 
works.

4. “Log into ProSphere” on page 102.

5. “Customize the security compliance message” on page 104.
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Add NICs for Isolated 
Networks

This chapter explains how to add ethernet adapters (NICs) to ProSphere virtual 
machines in order to facilitate working with isolated networks:

◆ Overview ........................................................................................................................  76
◆ Supported multiple NIC configurations....................................................................  76
◆ Configure an additional NIC on a ProSphere virtual machine ..............................  82
◆ Modify the /etc/hosts file ...........................................................................................  83

Note: NICs can be added only after the deployment is completed successfully. The network 
parameters for the newly added NIC can be configured when the VM is up and running.

On the EMC Online Support site, the white paper "ProSphere Multi-NIC Support" 
provides more details about installing NICs for isolated networks.
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Overview
In real-time data center environments, objects are usually distributed across different 
networks. Based on the security and firewall settings, access to 
isolated/non-routed/protected networks is usually restricted. From an 
administrator’s perspective, it is difficult to monitor objects in isolated networks. 
Multiple ProSphere instances must be deployed and configured, which requires 
additional resources. Reporting and analysis become tedious because data must be 
consolidated from different sources into a centralized database, often resulting in  
inconsistent real-time data. Correcting such problems is time-consuming and 
impractical. 

ProSphere attempts to overcome such challenges by allowing the user to add and 
configure additional NIC adapters. These adaptors allow ProSphere to easily connect 
to isolated networks, allowing discovery and monitoring of their objects

Supported multiple NIC configurations
The following sections list the different multiple NIC configurations supported by 
ProSphere.

Configurations 1 through 3 are used in normal deployments. Configurations 4 
through 6 are used in scale-out deployments.

Configuration 1: NICs on a DE
The objective of the configuration in “NICs on a Discovery Engine”  on page  77 is to 
monitor CIs connected to a data center LAN and CIs connected to an isolated LAN in 
a normal deployment.

The data center LAN handles typical ProSphere communications traffic such as: 

◆ Web Console connections

◆ Communications between the ProSphere Application, the Discovery Engine, and 
the Historical Database

◆ Communications to local CIs

The isolated network is not reachable from the ProSphere network. This network may 
be connected to multiple customer networks that are protected or isolated from the 
data center LAN.
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An example use for this configuration is a service provider environment where the 
customer manages multiple other client or customer CIs. The client or customer 
networks are not routed to the customer's corporate network.

Figure 3 NICs on a Discovery Engine

Configuration 2: NICs on a PA
The objective of the configuration in “NICs on a ProSphere Application”  on page  78 
is to federate a ProSphere instance connected to a data center LAN with another 
instance deployed in an isolated LAN.

The data center LAN handles typical ProSphere communications traffic such as: 

◆ Web Console connections

◆ Communications between the ProSphere Application, the Discovery Engine, and 
the Historical Database

◆ Communications to local CIs
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The isolated network is associated with the other ProSphere deployment, which is 
reachable only through the isolated network.

Figure 4 NICs on a ProSphere Application

Configuration 3: NICs on a PA and a Secondary PA
In the configuration shown in “NICs on a ProSphere Application and Secondary 
ProSphere Application”  on page  79, a Secondary ProSphere Application is 
configured and connected to a data center LAN.The objective is to federate a 
ProSphere instance with another instance deployed in an isolated LAN. 

The data center LAN handles typical ProSphere communications traffic such as: 

◆ Web Console connections

◆ Communications between the ProSphere Application, the Discovery Engine, and 
the Historical Database

◆ Communications to local CIs

More than one deployment of ProSphere exists. The deployments are synchronized, 
and the deployment associated with the data center LAN contains the Master 
Capacity Application. 
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The isolated network is associated with the other ProSphere deployment, which is 
reachable only through the isolated network.

A user of the non-master ProSphere Application may request performance data  for  
local CIs discovered by the Master Capacity Application. In this configuration, a 
Secondary ProSphere Application with a second NIC exists on the site of the Master 
Capacity Application.  The second NIC provides access to the performance data of 
these CIs.

Figure 5 NICs on a ProSphere Application and Secondary ProSphere Application

Configuration 4: NICs on a DE and a Collector
The objective of the configuration in “NICs on a Discovery Engine and Collector”  on 
page  80 is to monitor CIs that are connected to a data center LAN, and CIs connected 
to an isolated/non-routed LAN. 

The data center LAN handles typical ProSphere communications traffic such as: 

◆ Web Console connections

◆ Communications between the ProSphere Application, the Discovery Engine, the 
Historical Database, and Collectors
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◆ Communications to local CIs

The additional NIC facilitates communication with CIs from isolated network which 
are otherwise inaccessible through the data center LAN. 

The isolated network may be connected to multiple customer networks that are 
protected or isolated from the data center LAN.

Figure 6 NICs on a Discovery Engine and Collector

Configuration 5: NICs on a PA and a DE
The objective of the configuration in “NICs on ProSphere Application and Discovery 
Engine”  on page  81 is to monitor CIs that are connected to a usual data center and  
CI objects connected to an isolated LAN. The isolated LAN could also have a 
Collector deployed to provide a consolidated proxy for ProSphere traffic.

The data center LAN handles typical ProSphere communications traffic such as: 

◆ Web Console connections

◆ Communications between the ProSphere Application, the Discovery Engine, the 
Historical Database, and Collectors

◆ Communications to local CIs
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The additional NIC  on Discovery Engine facilitates communication with CIs from 
the isolated network that are otherwise inaccessible through the data center LAN. 
The isolated network may be connected to multiple customer networks that are 
protected or isolated from the data center LAN. The second NIC on the ProSphere 
Application grants access to the isolated network Collector to register with the 
Discovery Engine through the registration interface provided by ProSphere 
Application.

Figure 7 NICs on ProSphere Application and Discovery Engine

Configuration 6: NICs on a PA, a Secondary PA and a DE
The objective of the configuration in “NICs on ProSphere Applications and Discovery 
Engine”  on page  82 is to monitor CI objects at scale that are connected to a data 
center LAN, and CI objects connected to an isolated network. Isolated customer 
networks could also have a Collector installed to provide a consolidated proxy for 
ProSphere traffic. An additional NIC can also be configured on a Secondary 
ProSphere Application to gather the performance data supplied by the isolated 
network Collector for the CIs that are reachable only through isolated networks.

The data center LAN handles typical ProSphere communications traffic such as: 
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◆ Web Console connections

◆ Communications between the ProSphere Application, the Discovery Engine, the 
Historical Database, and Collectors

◆ Communications to local CIs

The isolated network communicates to CIs on a network that is not reachable from 
the data center LAN. The isolated network may be be connected to multiple customer 
networks that are protected or isolated from the data center LAN. The second NIC on 
the ProSphere Application grants the access to a Collector to register with the 
Discovery Engine through the registration interface provided by the ProSphere 
Application. The second NIC on the Secondary ProSphere Application allows a 
Collector to push the performance data to the Secondary ProSphere Application.

Figure 8 NICs on ProSphere Applications and Discovery Engine

Configure an additional NIC on a ProSphere virtual machine
The following procedure adds a NIC to a running system for use by the ProSphere 
Application, Discovery Engine, Collector, or Secondary ProSphere Application:

1. Add a new NIC to the virtual machine from the vSphere Console.
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2. Select Edit Settings on the virtual machine.

3. Click Add.

4. Select Ethernet Adapter, then click Next.

5. Select the adapter type VMXNET3 from the dropdown list, choose the network 
connection label that connects the new NIC to the isolated LAN, then click Next.

6. Review the options, and then click Finish.

Following is the procedure to configure the IP address and netmask details for the 
newly added NIC:

1. Log in to the virtual machine with SSH or through the vSphere console.

2. Assign the IP address and other network parameters to ETH1 (the NIC associated 
with the isolated network) using the following script: 
 
/opt/vmware/share/vami/vami_set_network vami_set_network 
<interface> (STATICV4) <ipv4_addr> <netmask> <gatewayv4> 
 
Example:  
 
/opt/vmware/share/vami/vami_set_network eth1 STATICV4 
172.16.60.239 255.255.0.0 1.31.148.1

Note: The <gatewayv4> address should be the default gateway address (the one that was 
entered when deploying ProSphere).

3. Run the ifconfig command and verify that all entries are correct.

Modify the /etc/hosts file
After the IP address is assigned to the ETH1, ensure that the ProSphere virtual 
machine is able to communicate and resolve the host names of CI objects from the 
isolated LAN, or the host names of another ProSphere virtual machine connected to 
Isolated LAN, in case you need to synchronize deployments.

If the host names are not included in the local DNS server, you must append the 
hostnames in the /etc/hosts file on the appropriate ProSphere virtual machine. 
The specific entries you must add would depend on which multi-NIC configuration 
you are setting up. 

In addition to adding hostnames manually in the /etc/hosts file, the user must 
add the entries in the subsequent boot script on the same virtual machine. This is 
required because the /etc/hosts file is overwritten on every reboot by the 
subsequent boot script, with default values that are pulled up from the ovfEnv.xml 
file. Thus, any manual changes to the /etc/hosts file must be specified explicitly in 
the subsequent boot script.

For example, if the user wants to add the following line into the /etc/hosts file:

172.16.60.239  ijk.lmn.com ijk

then the subsequent boot script /opt/vmware/etc/isv/ must be modified as 
follows:

echo "127.0.0.1 localhost.localdom localhost" > /etc/hosts 
echo "$HOSTADDR $FQDNADDR $SHORTHNAME" >> /etc/hosts 
echo "172.16.60.239 ijk.lmn.com ijk" >> /etc/hosts
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When using configuration 1 or 4, modify the /etc/hosts file on the Discovery 
Engine as follows: to allow host resolution, append the host name entries of the CI 
objects that belong to the isolated network the user intends to discover. 

When using configuration 2 or 3, modify the /etc/hosts on the master and 
non-master ProSphere Applications as follows: 

◆ On the master ProSphere Application, append the host name of the non-master 
ProSphere Application.

◆ On the non-master ProSphere Application, append the host name of the master 
ProSphere Application.

Table 5 on page 84 provides an example.

Table 5 Example: Modify the /etc/hosts file for configuration 2 or 3

VM FQDN Data center LAN Isolated network /etc/hosts file entry

When using configuration 5 or 6, modify the /etc/hosts file on the Discovery 
Engine as follows: to allow host resolution, append the host name entries of the CI 
objects that belong to the isolated network the user intends to discover. 

Also, when attempting to register the Collector located in the isolated network with 
the Discovery Engine, the user must append the /etc/hosts file entries of  
ProSphere Application,  Discovery Engine, and the Collector (on the isolated 
network) to a configuration similar to one shown in Table 6 on page 84: 

Table 6 Example: Modify the /etc/hosts file for configuration 5 or 6

VM FQDN Data center LAN Isolated network /etc/hosts file entry

Master abc1.xyz.com 1.31.91.62 172.16.60.239 172.16.60.251 ijk.lmn.com ijk

Non-master ijk.lmn.com 1.31.91.61 172.16.60.251 172.16.60.239 abc1.xyz.com abc1

ProSphere Application abc1.xyz.com 1.31.91.62 172.16.60.239 172.16.60.240 qrs.tuv.com qrs

Discovery Engine abc2.xyz.com 1.31.91.61 172.16.60.238 172.16.60.240 qrs.tuv.com qrs

Collector on isolated 
network

qrs.tuv.com - 172.16.60.240 172.16.60.239 abc1.xyz.com abc1
172.16.60.238 abc2.xyz.com abc2
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Deploy Collectors

This chapter provides instructions for deploying the ProSphere Discovery Engine 
Collector (Collector) to scale resource discovery to meet the needs of large data 
centers. Collectors are VMware virtual machines that must be deployed after initial 
ProSphere deployment because they coordinate their activities with an existing 
Discovery Engine.

The following sections provide details:

◆ Collector..........................................................................................................................  85
◆ Deploy Collectors with the vSphere Client ...............................................................  86
◆ Deploy Collectors with the vCloud Director ............................................................  89
◆ Register a Collector with the ProSphere Application ..............................................  90

Collector
The Collector allows you to scale ProSphere resource discovery and data collection to 
the size of your organization’s IT environment. Consult the EMC ProSphere 
Performance and Scalability Guidelines to determine the number of Collectors to deploy. 

Obtain deployment files
Ensure you downloaded files for the Collector from the EMC Online Support Site or 
another location specified by EMC mentioned in Table 7 on page 86. Place these files 
in a location accessible to the vSphere Client, such as a local file share or a URL 
location.

Determine the Collectors required for data center
Determine the number of Collector virtual machines required to scale ProSphere to 
your data center size.
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Collect information
Before deploying the Collector, contact your VMware Administrator to obtain the 
information needed for deployment, as presented in Table 7 on page 86.

Table 7 Deployment Fact Sheet

Type Specifics

If using vCloud, User should have required 
permissions in vCloud

Deploy Collectors with the vSphere Client

Note: Repeat this procedure for each Collector that you want to deploy.

1. Open the vSphere Client and connect to the vCenter Server managing the 
VMware environment.

2. Select File > Deploy OVF Template. 

IP address or hostname for the vCenter or 
vCloud server managing the VMWare 
environment

vCenter or vCloud server IP address or 
hostname

Username and password to connect the 
vSphere Client to the vCenter Server, or to log 
in to vCloud

Username

Password 

Permissions required for creating a catalog, 
uploading the vApp template, and 
deploying a vApp

Name for this deployment of the Collector (for 
example, “ProSphere Collector 1”)

Name for the Collector

Infrastructure location for the ProSphere 
Application. This may include a combination 
of Inventory Location, Host, Cluster, and 
Resource Pool

Inventory Location 

Host/Cluster

Disk format (Thick/Thin)

Resource Pool

Name of a data store in the vSphere 
environment to hold the Collector images

Data store

Names of the vSphere networks to deploy the 
Collector

Collector network

Location of downloaded deployment files Location of OVF file
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Note: Online help is available at each step of the Deploy OVF Template dialog box in the 
vSphere Client. But this help is not specific to ProSphere. Consult your VMware administrator 
if you are uncertain about any of these steps. For example, you may be uncertain about 
inventory location to select and so on.

3. In the Source step, browse to a file path or type a URL for the .ovf file. Click Next.

4. In the OVF Template Details step, review the details of the loaded .ovf file. Click 
Next.

5. In the End User License Agreement step, review the product license agreement 
and then click Accept and followed by Next.

6. In the Name and Location step, type a unique Name (for example, ProSphere 
Collector 1) and specify an Inventory Location in the VMware environment for 
the Collector. Click Next.

7. In the Host/Cluster step, select a choice — cluster, host, or both — on which the 
ProSphere vApp will run. Click Next.

8. In the Resource Pool step, select a resource pool (associated with the previously 
selected cluster/host) in which the Collector will run. This step is required only if 
a resource pool has been predefined. If you select the same Inventory Location 
and Host/Cluster as the ProSphere vApp, then select the vApp as the Resource 
Pool for the Collector as well.  
 
You can manage the Collector as part of the broader ProSphere vApp. To do this, 
move the Collectors inside the vApp container into Group1, along with other 
ProSphere machines. By default, the Shutdown Operation will be set to Power 
Off. This value does not permit a graceful shutdown of the Collector. 
 
Perform the following steps to allow the Collector to gracefully shut down:

a. Select Edit Settings.

b. Select the Start Order tab.

c. Under Shutdown Action, set the Operation to Guest Shutdown.

d. Set Shutdown sequence proceeds when to 600.

e. Click OK.

9. Click Next.

10. In the data store step, select a data store to hold the virtual machine image for the 
Collector. The data store should have a minimum 30 GB of space available for a 
Thick disk format and 2.2 GB for a Thin disk format. Click Next.

11. In the Disk Format step, for some data stores you are required to select the 
storage space provisioning method for the virtual machine. 

Example options include: ◆ Thin provisioned format (on demand expansion of available storage for the 
virtual machine) for newer data store file systems

◆ Thick provisioned format (virtual machine storage is allocated and reserved as a 
block)

Click Next.

12. In the Network Mapping step, select a destination network for the Collector. 
Click Next.
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Note: In the VMware environment, each selected destination network must have an IP 
Pool associated with it.

13. In the Properties step, specify the required configuration fields. The description 
of a property appears in red if the required value is missing or incorrect from the 
dialog box. 

Note: Ensure you specify only the relevant DNS and search domains.

The properties to set are:

Property Group Purpose Property Description

Note: Be sure to enter a value. Otherwise, 
when collecting host data DNS resolution 
fails and hosts discovered on the affected 
element managers will not appear in the 
Objects List.

Click Next.

14. In the Ready to Complete step, review the list of properties that you specified for 
deployment. If you need to change a value, click Back to return to the previous 
steps and change a listed value. Click Finish to start the deployment. A status bar 
is displayed in the vSphere Client, showing the deployment progress.

Wait for the Deployment Completed Successfully dialog box to appear.

15. Click Close to close the dialog box.

16. In the vSphere Client, navigate to the Hosts & Clusters view.

a. Expand the tree in the left panel of this view.

b. Locate the cluster and host that you selected for Collector during deployment. 

Collector Information Configures the vApp Collector Appliance 
Hostname

Hostname to assign to the Collector (for 
example, ProSphere Collector 1)

Collector Appliance 
IP Address

IP address to assign to the Collector if a 
fixed IP address scheme is in use 

Collector Appliance 
Gateway

Subnet gateway for hosts in the network

Collector Appliance 
Netmask

Netmask applied to IP addresses in the 
network

Collector Appliance 
DNS Server(s)

Comma-separated list of DNS available in 
the network selected for the ProSphere 
Application and the DNS for KDC.

Collector Search 
Domain(s)

Comma-separated list of domains used in 
the network selected and the domain 
name for KDC.

Uncategorized Configures the 
Collector

Timezone setting Server time zone to set on the virtual 
machines deployed as part of ProSphere
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Deploy Collectors with the vCloud Director
This section includes the following procedures:

◆ “Upload the new deployment file to the catalog”  on page  89

◆ “Deploy the Collector vApp from the vApp template”  on page  89

◆ “Modify action and delay settings”  on page  90

Upload the new deployment file to the catalog
1. In the Catalogs tab, select the catalog you created.

2. Select the Media tab.

3. Click the wheel icon to bring up an option menu then select Upload. This 
displays the Upload Media dialog box. 

4. Click Browse and select the .ovf file. After uploading, the file will be stored with 
the other files in the vApp Template. 

5. Enter a name for the vApp Template in the Name field.

6. Enter a description for the vApp Template (such as the Collector vApp).

7. Click Upload. A progress screen displays the progress of the upload operation.

Note: The progress screen does not appear if popup blockers is enabled in your web browser.

8. When the upload operation is completed, click Clear.

Deploy the Collector vApp from the vApp template
1. Click the My Cloud tab. 

2. Left-click the plus (+) button to display the Add vApp from Catalog dialog box.

3. Select the template and click Next.

4. Read and accept EULA and click Next. 

5. Type a name for the vApp.

6. Type a description for the vApp, and click Next.

7. Select the virtual datacenter from the dropdown list.

8. Select a storage profile from the dropdown list and click Next.

9. Select Static-Manual as the IP allocation and click Next.

10. Enter the IP address and enter network parameters for each the Collector.The 
following list contains sample data:

a. IP Range: xx.xxx.xx. 01-03

b. Hostname Range: xxxxx01-03

c. Netmask: xxx.xxx.xxx.0

d. Gateway: xx.xxx.xx.x

e. DNS: xx.xxx.xx.xx, yy.yyy.yy.yy
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Note: Enter at most two IP addresses in the DNS field. 

f. DNS Search Path domain: com test.test;.com test.corp.com,test.com

Note: Be sure to enter a DNA Search Path domain value. Otherwise, when collecting host data 
DNS resolution fails and hosts discovered on the affected element managers will not appear in 
the Objects List.

11. Select a time zone. Click Next. The Ready to Complete dialog appears. 

12. Check that the information is correct.

13. Click Finish. The vApp is listed in the My Cloud window.

14. When deployment has completed successfully, in the My Cloud window select 
the vApp for the Collector and select Start.

15. If you need to modify the default lease settings of seven days, follow these steps:

a. Right-click the vApp and navigate to Properties > General > Lease.

b. Select the lease settings recommended by your vCloud administrator.

c. Follow the wizard instructions and click Finish.

Modify action and delay settings
1. In the My Cloud window, click the vApp tab, right-click Collector and select 

Properties.

2. Click the Starting and Stopping VMs tab.

3. Change the Boot Delay (seconds) value to 120.

4. Change the Stop Delay (seconds) value to 600.

5. Change the Stop Action to Shutdown.

Register a Collector with the ProSphere Application
You can deploy additional Collectors as required. After deploying a Collector, 
register it with the ProSphere Application that manages it.

To register a Collector with the ProSphere Application:

1. Type the Collector URI https://<collector_name>/appliance_registration.html in 
the web browser window.

2. Type the ProSphere Application hostname.

3. Type the Security Administrator credentials.

4. Click Submit.

After a successful registration of the Collector with the ProSphere Application, a 
confirmation dialog appears.

Note: “Deploy Collectors with the vSphere Client” on page 86 provides information on 
deploying additional Collectors.
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Load balance Collectors 
The primary Discovery Engine automatically load balances the discovery requests 
across all available Collectors. You do not have to specify which Collector to use for 
each discovery job.
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Deploy Secondary 
ProSphere Application

This chapter provides instructions for deploying a Secondary ProSphere Application. 
In rare cases ProSphere collects an extremely large amount of performance data, 
which might degrade the overall ProSphere performance. To meet such needs, you 
can add a Secondary ProSphere Application at any time after deploying ProSphere.

Note: The EMC ProSphere Performance and Scalability Guidelines provides information about 
when to use a Secondary ProSphere Application.

The following sections provide details:

◆ Secondary ProSphere Application..............................................................................  94
◆ Deploy a Secondary ProSphere Application with the vSphere Client ..................  96
◆ Deploy a Secondary ProSphere Application with the vCloud Director ...............  98
◆ Register a Secondary ProSphere Application ...........................................................  99
Deploy Secondary ProSphere Application 93
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Secondary ProSphere Application
A Secondary ProSphere Application receives a share of data routed to the ProSphere 
Application. This results in an increased CPU availability and enhances ProSphere 
performance. 

Note: A Secondary ProSphere Application does not have a functional user interface.

Limitation
During the deployment of a Secondary ProSphere Application, when performance 
data collection is shifted from the ProSphere Application to the Secondary ProSphere 
Application, most likely a data point will be dropped for any metric that is calculated 
using a counter/delta. This includes most metrics.

The reason is that for metrics calculated with a counter/delta, the calculation cannot 
occur without two collected data points.  The intermediate JSON/XML data files 
collected on the ProSphere Application are not migrated to the Secondary ProSphere 
Application, so the Secondary ProSphere Application does not have the previous 
data locally available for calculation. By design, the Secondary ProSphere 
Application will not produce a data point for the interval directly after the migration.  
This omission is observable in the pdc-server log file.  Subsequent data collection, 
calculation, and display should be normal, because it occurs after a second interval 
has passed and another set of metrics is collected for calculation against a previous 
set.

This observed behavior (missing data point) should not apply to metrics like Unix 
Host CPU %Busy that are reported directly without doing counter/delta calculations.  
For these metrics, the previous data is not used for calculations, and the next data 
point should appear as scheduled.

Obtain deployment files
Ensure you downloaded files for the Secondary ProSphere Application from the EMC 
Online Support Site or another location specified by EMC mentioned in Table 8 on 
page 95. Place these files in a location accessible to the vSphere Client, such as a local 
file share or a URL location.
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Collect information
Before deploying a Secondary ProSphere Application, contact your VMware 
Administrator to obtain the information needed for deployment, as presented in 
Table 8 on page 95.

Table 8 Deployment Fact Sheet

Type Specifics

IP address or hostname for the vCenter or 
vCloud server managing the VMWare 
environment

vCenter or vCloud server IP address or 
hostname

Username and password to connect the 
vSphere Client to the vCenter Server, or to log 
in to vCloud

Username

Password 

If using vCloud, User should have required 
permissions in vCloud

Permissions required for creating a catalog, 
uploading the vApp template, and 
deploying a vApp

Name for this deployment of the ProSphere 
Application (for example, “ProSphere 
Application 2”)

Name for the ProSphere Application

Infrastructure location for the ProSphere 
Application. This may include a combination 
of Inventory Location, Host, Cluster, and 
Resource Pool

Inventory Location 

Host/Cluster

Disk format (Thick/Thin)

Resource Pool

Name of a data store in the vSphere 
environment to hold the Secondary ProSphere 
Application images

Data store

Names of the vSphere networks to deploy the 
Secondary ProSphere Application

Secondary ProSphere Application network

Desired secure access and network properties 
for the Secondary ProSphere Application 
virtual machine

DNS servers (separated by commas)

Search domain strings (separated by spaces)

Hostname

IP address
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Deploy a Secondary ProSphere Application with the vSphere Client 
1. Open the vSphere Client and connect to the vCenter Server managing the 

VMware environment.

2. Select File > Deploy OVF Template. 

Note: Online help is available at each step of the Deploy OVF Template dialog box in the 
vSphere Client. But this help is not specific to ProSphere. Consult your VMware administrator 
if you are uncertain about any of these steps. For example, you may be uncertain about 
inventory location to select and so on.

3. In the Source step, browse to a file path or type a URL for the .ovf file. Click Next.

4. In the OVF Template Details step, review the details of the loaded .ovf file. Click 
Next.

5. In the End User License Agreement step, review the product license agreement 
and then click Accept and followed by Next.

6. In the Name and Location step, type a unique Name (for example, ProSphere 
Application 1) and specify an Inventory Location in the VMware environment 
for the Secondary ProSphere Application. Click Next.

7. In the Host/Cluster step, select a choice — cluster, host, or both — on which the 
ProSphere vApp will run. Click Next.

8. In the Resource Pool step, select a resource pool (associated with the previously 
selected cluster/host) in which the Secondary ProSphere Application will run. 
This step is required only if a resource pool has been predefined. Click Next.

Note: The Secondary ProSphere Application is deployed external to the ProSphere vApp (not 
in the same vApp as the ProSphere Application) . You cannot manage the Secondary ProSphere 
Application as part of the ProSphere vApp.

9. In the data store step, select a data store to hold the virtual machine image for the 
Secondary ProSphere Application. The data store should have a minimum of 230 
GB space available. Click Next.

10. In the Disk Format step, for some data stores you are required to select the 
storage space provisioning method for the virtual machine. 

Example options include: ◆ Thin provisioned format (on demand expansion of available storage for the 
virtual machine) for newer data store file systems

◆ Thick provisioned format (virtual machine storage is allocated and reserved as a 
block)

Click Next.

Netmask

Subnet gateway

Location of downloaded deployment files Location of OVF file

Table 8 Deployment Fact Sheet

Type Specifics
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11. In the Network Mapping step, select a destination network for the Secondary 
ProSphere Application. Click Next.

Note: In the VMware environment, each selected destination network must have an IP 
Pool associated with it.

12. In the Properties step, specify the required configuration fields. The description 
of a property appears in red if the required value is missing or incorrect from the 
dialog box. 

Note: Ensure you specify only the relevant DNS and search domains.

The properties to set are:

Property Group Purpose Property Description

Click Next.

13. In the Ready to Complete step, review the list of properties that you specified for 
deployment. If you need to change a value, click Back to return to the previous 
steps and change a listed value. Click Finish to start the deployment. A status bar 
is displayed in the vSphere Client, showing the deployment progress.

Wait for the Deployment Completed Successfully dialog box to appear.

14. Click Close to close the dialog box.

15. In the vSphere Client, navigate to the Hosts & Clusters view.

a. Expand the tree in the left panel of this view.

Secondary 
ProSphere 
Application 
Information

Configures the vApp Secondary 
ProSphere 
Application 
Hostname

Hostname to assign to the Secondary 
ProSphere Application (for example, 
ProSphere Application 1)

Secondary 
ProSphere 
Application IP 
Address

IP address to assign to the Secondary 
ProSphere Application if a fixed IP address 
scheme is in use 

Secondary 
ProSphere 
Application Gateway

Subnet gateway for hosts in the network

Secondary 
ProSphere 
Application Netmask

Netmask applied to IP addresses in the 
network

Secondary 
ProSphere 
Application DNS 
Server(s)

Comma-separated list of DNS available in 
the network selected for the Secondary 
ProSphere Application and the DNS for 
KDC.

Secondary 
ProSphere 
Application Search 
Domain(s)

Comma-separated list of domains used in 
the network selected and the domain 
name for KDC.

Uncategorized Configures the 
Secondary 
ProSphere 
Application

Timezone setting Server time zone to set on the virtual 
machines deployed as part of ProSphere
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b. Locate the cluster and host that you selected for the Secondary ProSphere 
Application during deployment. 

Deploy a Secondary ProSphere Application with the vCloud Director
This section includes the following procedures:

◆  “Upload the new deployment file to the catalog”  on page  98

◆  “Deploy the Secondary ProSphere Application from the vApp template”  on 
page  98

◆  “Modify action and delay settings”  on page  99

Upload the new deployment file to the catalog
1. In the Catalogs tab, select the catalog you created.

2. Select the Media tab.

3. Click the wheel icon to bring up an option menu then select Upload. This 
displays the Upload Media dialog box. 

4. Click Browse and select the .ovf file. After uploading, the files will be stored as a 
vApp Template. 

5. Enter a name for the vApp Template in the Name field.

6. Enter a description for the Secondary ProSphere Application vApp Template 
(such as ProSphere vApp).

7. Click Upload. A progress screen displays the progress of the upload operation.

8. When the upload operation is completed, click Clear.

Note: In the My Cloud area on the vApps screen, if all three virtual machines are listed under 
the vApp template with Powered Off status, this indicates that the upload of the OVF and 
VMDK files was successful.

Deploy the Secondary ProSphere Application from the vApp template
1. Click the My Cloud tab. 

2. Left-click the plus (+) button to display the Add vApp from Catalog dialog box.

3. Select the template and click Next.

4. Read and accept EULA and click Next. 

5. Type a name for the vApp.

6. Type a description for the vApp, and click Next.

7. Select the virtual datacenter from the dropdown list.

8. Select a storage profile from the dropdown list and click Next.

9. Select Static-Manual as the IP allocation and click Next.

10. Enter the IP address and enter network parameters for the Secondary ProSphere 
Application.The following list contains sample data:

a. IP Range: xx.xxx.xx. 01-03
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b. Hostname Range: xxxxx01-03

c. Netmask: xxx.xxx.xxx.0

d. Gateway: xx.xxx.xx.x

e. DNS: xx.xxx.xx.xx, yy.yyy.yy.yy

Note: Enter at most two IP addresses in the DNS field. 

f. DNS Search Path domain: com test.test;.com test.corp.com,test.com

11. Select a time zone. Click Next. The Ready to Complete dialog appears. 

12. Check that the information is correct.

13. Click Finish. The vApp is listed in the My Cloud window.

14. When deployment has completed successfully, in the My Cloud window select 
the vApp for the Secondary ProSphere Application and select Start.

15. If you need to modify the default lease settings of seven days, follow these steps:

a. Right-click the vApp and navigate to Properties > General > Lease.

b. Select the lease settings recommended by your vCloud administrator.

c. Follow the wizard instructions and click Finish.

Modify action and delay settings
1. In the My Cloud window, click the vApp tab, right-click the Secondary ProSphere 

Application and select Properties.

2. Click the Starting and Stopping VMs tab.

3. Change the Boot Delay (seconds) value to 120.

4. Change the Stop Delay (seconds) value to 600.

5. Change the Stop Action to Shutdown.

Register a Secondary ProSphere Application
After deploying a Secondary ProSphere Application, register it with the ProSphere 
Application that manages it.

To register a Secondary ProSphere Application:

1. Type the Secondary ProSphere Application URI 
https://<secondary_prosphere_application_name>/appliance_registration.html 
in the web browser window.

2. Type the hostname of the managing ProSphere Application.

3. Type the Security Administrator credentials.

4. Click Submit.

After a successful registration of the Secondary ProSphere Application with the 
ProSphere Application, a confirmation dialog appears.
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Post-Deployment Tasks

This chapter provides instructions to follow after the deployment of ProSphere. The 
following sections detail ProSphere post-deployment steps:

◆ Synchronize time zones and system times ..............................................................  102
◆ Log into ProSphere......................................................................................................  102
◆ Customize the security compliance message..........................................................  104
◆ Integrate ProSphere with Unisphere for VMAX ....................................................  105
◆ Configure CMCNE/BNA ..........................................................................................  109
◆ Prepare for alert integration ....................................................................................... 113
◆ Synchronize ProSphere deployments ....................................................................... 114
◆ Integrate ProSphere with Watch4net......................................................................... 114
◆ Deploy trusted certificates .......................................................................................... 115
◆ Additional information ............................................................................................... 115
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Synchronize time zones and system times
After deploying ProSphere, so that SPA and Brocade path performance data 
collection and alert consolidation will occur as expected, ensure the following:

◆ Time zone and system times of ProSphere and the host running BNA or CMCNE 
are synchronized

◆ System times of ProSphere and the hosts running SPA are synchronized

Log into ProSphere
1. Open a Web browser and browse to the ProSphere Application by specifying the 

URL address (using the IP address or hostname) of the virtual machine where the 
ProSphere Application was deployed.

Note: Ensure you enable Transport Layer Security (TLS) 1.0 in Web browser security 
settings.

2. Accept any security-related dialog box that may appear in the browser asking 
you to accept a security certificate from EMC (or allow a security exception for 
ProSphere) and continue. 

Note: The procedure to accept the certificate varies between browsers and even between 
different versions of the same browsers. To prevent the dialog box from appearing at login, 
import the certificate from the host you have established.

3. Type the default username and password for ProSphere at the login screen 
(shown in the figure):

appadmin in the User field

Changeme1! in the Password field

Note: The username, appadmin, and the password, Changeme1!, are predefined and 
assigned the roles Security Administrator, System Administrator, and User. You should 
change the password for this account immediately after the first login.
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4. Click Login. The ProSphere Console is loaded and appears in the browser as 
shown in the figure.
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Note: Be aware that after the credentials are accepted and before the ProSphere Console is 
visible, a quick health check is done and the user is warned about problems that might interfere 
with normal operation. This includes but is not limited to problems such as the ProSphere 
Application being unable to locate a Discovery Engine over the network.

Customize the security compliance message
Security Administrators can specify security compliance requirements in a message 
users must acknowledge before accessing ProSphere. 

If such a message is added, it will be shown to the users in the login banner.
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Create or edit the message

Note: Ensure that the message is clear to the users and that its security claims are correct.

1. Click Admin on the ProSphere Console.

2. Click the Users and Security tab. 

3. Click Customize Login Banner. The Customize Login Banner dialog box 
appears.

4. Type the message. 
 
OR 
 
Edit the existing message.

5. Click Save.

Integrate ProSphere with Unisphere for VMAX

Note: The EMC ProSphere Support Matrix provides the minimum version requirements for 
Unisphere for VMAX.

The following are prerequisites for successful Unisphere for VMAX launch-in-context 
integration.

◆ Preferably, only one Unisphere for VMAX instance manages each Symmetrix 
array. If more than one Unisphere for VMAX instance manages a Symmetrix 
array, all instances must meet the minimum version requirements and must be 
the same version.

◆ You must have existing, supported versions of Unisphere for VMAX in the data 
center on a host that can be accessed through HTTP(S) by the ProSphere virtual 
machines. Ensure that no firewalls block their direct communication. The 
Unisphere for VMAX Installation Guide provides installation instructions. 
Installation of Unisphere for VMAX is independent of ProSphere installation.

◆ On arrays used to launch Unisphere for VMAX, associate ProSphere user 
accounts with the Admin or Monitor role:

• In ProSphere, create user accounts to authorize ProSphere users who will 
launch Unisphere for VMAX in context. 

• In Unisphere for VMAX, on each array where a specific ProSphere user 
account will be used to launch Unisphere for VMAX, assign the Admin or 
Monitor role to the account. 

◆ In Unisphere for VMAX, register Unisphere for VMAX arrays to collect 
performance data.

◆ Associate a ProSphere SMC-SPA access credential with a Unisphere for VMAX 
launch client. 

• In ProSphere, create an SMC-SPA access credential.

• In Unisphere for VMAX, register a launch client. Assign the username and 
password used to create the Unisphere for VMAX-SPA access credential in 
ProSphere. 

◆ In ProSphere, rerun the discovery jobs that discovered the Symmetrix arrays.
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Perform the following configuration steps:

1. In ProSphere, ensure that user accounts exist for users who will launch Unisphere 
for VMAX in context. To authorize a ProSphere user, navigate to Admin > Users 
and Security and click Create user. 

2. In Unisphere for VMAX, authorize each ProSphere user who will launch 
Unisphere for VMAX. When you authorize a user, assign the role Admin or 
Monitor (which has fewer permissions) on each array where the user will launch 
Unisphere for VMAX.  This authorizes the user to launch Unisphere for VMAX 
on the specified array.  For example, suppose John Doe is an authorized 
ProSphere user who will launch Unisphere for VMAX from ProSphere. In 
Unisphere for VMAX, on each array where John Doe will launch Unisphere for 
VMAX, assign the Admin role to John Doe at the Create Authorization Rules 
dialog box.

Note: The appadmin account exists by default in ProSphere. You can create an appadmin user 
in Unisphere for VMAX in order to use the ProSphere appadmin account to launch Unisphere 
for VMAX in context from ProSphere. 

3. To collect Array FE Directors - % Busy data for a Symmetrix array, register the 
array for Performance data (assuming that Unisphere for VMAX was installed 
with the Performance Analytics option). 

a. Navigate to Performance > Settings > System Registrations.

b. Select one or more Symmetrix arrays and click Register.  
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c. Select the Diagnostic collection. The Register screen displays the array with a 
green indicator icon in the Diagnostic checkbox.

d. In addition, for the Array FE Directors - % Busy metric chart, ensure the 
metric FE Director - % Busy is enabled (it should be by default).  To verify, 
navigate to Performance > Settings > Metrics.  Click the filter button and 
select FE Director. 

4. In ProSphere, create an access credential with the type SMC-SPA. Navigate to 
Discovery > Access Credentials > Create Access Credential.
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Note: Only one access credential with the type SMC-SPA can exist in a single deployment of 
ProSphere. If Unisphere for VMAX is installed on more than one array in a deployment, use the 
same SMC-SPA access credential (with the same client id) for all instances of Unisphere for 
VMAX in the deployment. If you have more than one ProSphere deployment, assign a unique 
client id to the SMC-SPA access credential in each deployment.

Note: After you create an SMC-SPA access credential in a ProSphere deployment, the option of 
creating another will not be available in the drop-down list of the Create Access Credentials 
dialog box in that deployment.

5. Register a launch client in all Unisphere for VMAX instances in the deployment.

a. Navigate to Administration > Link and Launch.

b. Click Create.
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c. Enter the alphanumeric client ID and a password.  All information in the 
SMC-SPA access credential created in ProSphere (username and password) 
must match the client information entered in Unisphere for VMAX. 

d. Restart Unisphere for VMAX. 

Note: Whenever you add a client in Unisphere for VMAX, you must restart it. If you do not, 
authentication fails.

6. From the Discovery view of ProSphere, rerun the discovery jobs that discovered 
the Symmetrix arrays. This validates the SMC-SPA access credentials for all 
Unisphere for VMAX URLs discovered for the arrays. Both Performance Data 
Collection and Alerts Collection Status log message windows display 
appropriate error messages.

Note: When you rerun the discovery jobs, you do not need to change any information 
including access credential. The discovery job uses the SMC-SPA access credential that is 
available in the system for performance detection.

Configure CMCNE/BNA
This section applies to homogenous and mixed fabrics that contain one or more 
Brocade FC managed by the Connectrix Manager Converged Network Edition 
(CMCNE)/Brocade Network Advisor (BNA).

The support.emc.com website provides CMCNE software and documentation.

CMCNE
CMCNE is a unified network management solution for data, storage, application 
delivery, wireless, and converged networks. It provides a single interface for Brocade 
Fibre Channel SANs, IP networks, wireless networks, and Multiprotocol Label 
Switching (MPLS) networks — providing end-to-end visibility across different 
network types through a seamless and unified user experience.

Note: CMCNE will discover and report back on Brocade EOS switches.
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Configure CMCNE/BNA for launch in context
Perform the following steps before attempting to launch in context from ProSphere to 
Brocade:

1. Download the ProSphere Server certificate (apache certificate) from ProSphere 
Console > Admin > Users and Security > Export Certificate.

Note: The EMC ProSphere Security and Configuration Guide provides a detailed procedure to 
import the ProSphere Server certificate.

2. Import it to the CMCNE/BNA Server using either option a or b:

a. Use the keytoolutil.bat file located in the following location to import 
the certificate: <CMCNE/BNA installation-folder>\bin 
 
The alias name used can be the server shortname. 

b. Use the keytool.exe available by default in the following location on 
CMCNE/BNA hosts: <CMCNE/BNA installation-folder>\jre\bin 
 
When you execute the keytool.exe.file, use the default admin password for 
BNA, or CMCNE, as appropriate. The following example shows how to 
execute the keytool.exe file on BNA: 
 
CMCNE/BNA installation-folder>\jre\bin>keytool 
-importcert -v - 
file d:\serverCertificate.crt -alias prosphere 
Enter keystore password: <default admin password> 
Re-enter new password:<default admin password> 
Owner: CN=aownlmsspro01.ecc.mssmgt.com 
Issuer: CN=aownlmsspro01.ecc.mssmgt.com 
Serial number: afddf19db0f238bb 
Valid from: Thu Jun 21 13:35:51 CEST 2012 until: Tue Jun 
20 
13:35:51 CEST 2017 
Certificate fingerprints:

MD5: 28:EB:09:3E:DE:2C:E7:68:A4:0B:F3:56:78:80:DB:33 
SHA1: F1:57:FF:

71:77:F3:16:72:97:BA:B0:A4:DF:FD:D5:17:3B:A3:10:8A

Signature algorithm name: SHA1withRSA 
Version: 3

Extensions: 
#1: ObjectId: 2.5.29.14 Criticality=false 
SubjectKeyIdentifier [ 
KeyIdentifier [ 
0000: 98 79 6C 28 4B 2E 64 11 C3 A5 30 CA 91 6F 4E 
FB .yl(K.d...0..oN. 
0010: 85 EF 02 89 
] 
] 
#2: ObjectId: 2.5.29.19 Criticality=false 
BasicConstraints:[
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CA:true 
PathLen:2147483647

] 
#3: ObjectId: 2.5.29.35 Criticality=false 
AuthorityKeyIdentifier [ 
KeyIdentifier [ 
0000: 98 79 6C 28 4B 2E 64 11 C3 A5 30 CA 91 6F 4E 
FB .yl(K.d...0..oN. 
0010: 85 EF 02 89 .... 
] 
[CN=aownlmsspro01.ecc.mssmgt.com] 
SerialNumber: [ afddf19d b0f238bb] 
] 
Trust this certificate? [no]: yes 
Certificate was added to keystore 
[Storing C:\Users\nl06328\.keystore]

3. Restart the CMCNE/BNA service after importing the server certificate.

4. Create a CMCNE/BNA user whose username matches the ProSphere user 
credentials. From the CMCNE/BNA user management user interface, create a 
local user whose name matches the ProSphere user id (for example, appadmin).

5. Add any fabrics that are discovered in ProSphere to an Area of Responsibility in 
CMCNE/BNA, and assign them to the user account you will use to launch 
CMCNE/BNA, as shown in the following screen.
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Note: If you need to launch CMCNE/BNA from any discovered fabric, assign the user account 
to the following Responsibility: All Fabrics. It you do not want to assign permissions that allow 
the account to launch from any discovered fabric, create an Area of Responsibility that is a 
subset of the discovered fabrics and assign it to the user account..

6. ProSphere should be able to do a DNS lookup of the CMCNE/BNA host to 
determine the FQDN of CMCNE/BNA host. If there are firewalls between the 
ProSphere host and CMCNE/BNA, configure the firewalls to enable the DNS 
lookup to work correctly.

7. The computer name of the Windows host where CMCNE is running should be set 
to the FQDN of the host. For example, if the FQDN is 
cmcne-host.lss.emc.com, and if the Computer Name is set to cmcne-host, 
Launch In-Context will not work. The Computer Name should be set to 
cmcne-host.lss.emc.com.

Note: The EMC ProSphere Support Matrix lists the CMCNE version supported by ProSphere. 

Authorize ProSphere users with the SMIA Configuration Tool

Note: There will be port contention if CMCNE and another SMI Cimom are installed on the 
same host and they both use the default ports 5988 and 5989.
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On the Brocade CMCNE host do the following: 

1. Start > All Programs > CMCNE > Server Management Console. 

2. If you are not logged in as administrator, right-click on the Server Management 
Console and select Run as administrator.

3. In the CMCNE Server Console, click the Services tab.

4. Click Restart. The message “Stopping Services will cause CMCNE Clients …. “  
appears. 

5. Click Yes.

6. When the restart has completed and the Status column displays Started, click 
Configure SMI Agent.

7. In the SMIA Configuration Tool Log in window, enter user ID and password.

• Default User name: Administrator

• Default Password: password

8. Click Login.

9. In the SMIA Configuration Tool under the Home tab, click the Users option.

10. In the Users window under the Users tab, click Add.

11. In the Add User window, perform the following steps for each ProSphere user:

a. Enter the ProSphere user name. 

b. Enter the ProSphere password.

c. Move all fabrics from Available Roles / AOR TO Selected Roles /AOR.

d. Move SAN System Administrator from Available Roles / AOR to Selected 
Roles /AOR.

e. Once all have been moved click OK.

12. In the Users window under the Users tab you should see the ProSphere users in 
the list under Users. 

Note: ProSphere should be able to do a DNS lookup of the CMCNE host. Verify that all ports 
are open between ProSphere and the CMCNE server if firewalls exist between the applications. 
Bear in mind that host-based software firewalls can block communications and must be 
configured as well. 

Update Licenses
On the Brocade CMCNE host perform the following steps to update licenses:

1. Launch CMCNE by selecting the Start > All Programs > CMCNE > CMCNE or 
by double-clicking the CMCNE icon on the desktop, and log in.

2. From the main (View All) window, select Help > License.

3. In the License window, enter the license key or use browse to locate the license 
key file, and click OK.

Prepare for alert integration
Ensure that you record the following details in order to create access credentials for 
Unisphere Remote for VNX and DCNM alert sources in the ProSphere UI.
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Obtain the following Unisphere Remote for VNX details. These details are required in 
order to create an access credential for the Unisphere Remote instance as an alert 
source:

◆ Port where the Unisphere Remote instance is installed: 

________________________________

◆ Username used during installation or configured after installation:

________________________________

◆ Password used during installation or configured after installation:

________________________________

Obtain the following DCNM details: 

◆ SAN Web Service Port where the DCNM instance is installed:

________________________________

◆ Username used during installation or configured after installation:

________________________________

◆ Password used during installation or configured after installation:

________________________________

Synchronize ProSphere deployments
The procedure for deploying multiple ProSphere or Collector deployments is the 
same as for a single deployment. However, make sure you create a common 
Administrator credential for all the deployments and use only this credential to log 
into ProSphere when you intend to synchronize multiple ProSphere deployments.

The EMC ProSphere Administrator Guide and online help contains information about 
synchronizing multiple ProSphere Applications. Go to Home > Administering 
ProSphere > System > Synchronize ProSphere Applications > Synchronize 
Multiple ProSphere Applications dialog.

Integrate ProSphere with Watch4net
You can integrate ProSphere with Watch4net and enable report generation in 
Watch4net related to the ProSphere performance. 

You can disable the SRM Suite integration whenever necessary—for example, when 
the Watch4net instance is going to be down. 

Whenever the IP address or port of the Watch4net is changed, you should change the 
SRM Suite integration settings. 

In a federated ProSphere setup, integrate the SRM suite at each instance of ProSphere.   

1. Click Admin on the ProSphere Console. 

2. Click Configure SRM Suite Integration on the System tab. The Configure SRM 
Suite Integration dialog box appears.

3. Select Enable integration.

a. Type the FQDN or IP address of the host in the Host field. This field supports 
a maximum of 63 alphanumeric characters including underscores ( _ ), periods 
( . ), dashes ( - ), and forward slashes ( / ).
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b. Type the port number in the Port field. This field supports a maximum of 5 
digits in the range of 1 to 65535.

c. Keep the default value in the Group field. 

4. Click OK.

Note: To disable integration, you would select Disable integration at the Configure SRM 
Suite Integration dialog box.

Deploy trusted certificates
Deploy organization-specific, trusted certificates through the ProSphere Console. 
ProSphere is deployed with unsigned certificates. ProSphere supports only X.509 
certificates. For added security, EMC recommends obtaining and deploying signed 
certificates specific to your organization. Certificate deployment can be performed in 
the ProSphere Console. The EMC ProSphere Security and Configuration Guide contains 
more information about importing and exporting certificates.

Additional information
The EMC ProSphere Documentation Library, which is accessible from the ProSphere 
Console, contains additional information and assistance. 

To display the library, right click the Help button (?), then select Search All 
Documentation.

Figure 9 Display the EMC ProSphere documentation library
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Updates and Backups

Updates to EMC ProSphere are made separately to each virtual machine, from a Web 
browser. 

This chapter explains how to deploy updates to ProSphere and includes the following 
sections:
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◆ Create and restore snapshots or backups ................................................................  130
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Updates and Backups 117



Updates and Backups
Overview
EMC may periodically provide you with updates to ProSphere. Updates can 
represent fixes, improvements, and additions to ProSphere documentation and 
functionality. Not all updates may affect all virtual machines in ProSphere. Consult 
your update documentation for specific details and instructions.

IMPORTANT!
ProSphere 2.0.1.5 has a modified update process and data loss can occur if it is not 
followed properly. It is imperative that a VM snapshot be taken prior to the entire 
update process which will allow you to recover from any potential data loss 

IMPORTANT!
Before updating ProSphere, EMC recommends that you power off the ProSphere 
vApp and additional ProSphere virtual machines (Collectors and any Secondary 
ProSphere Application virtual machine). Take a snapshot and power on the vApp 
and virtual machines, then apply the update.

IMPORTANT!
In a federated site, use the following sequence when applying updates to ensure 
that federated groups, tags, and rediscovery of configuration items work as 
expected.  
 
1. Update the master and non-master sites in parallel.  
2. When the update completes, reboot the master site before rebooting the 
non-master sites.  
Wait for reboot and data migration to complete on the master site before logging in 
to the non-master sites to ensure that all features affected by federation work as 
expected. 
3. Manually resynchronize all ProSphere Applications from Admin > System > 
Synchronize ProSphere Application. 

IMPORTANT!
After you upgrade from ProSphere 1.7, if the UI displayed is the 1.7 ProSphere UI, 
clear the browser cache and launch a fresh browser session.
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ProSphere update methods
The virtual machines in ProSphere include the following:

◆ ProSphere Application

◆ Discovery Engine and any Collectors

◆ Historical Database

Table 9 on page 119 details the ways perform updates on ProSphere virtual machines.

Table 9 Update Details

Source Extension Action Method

Download an ISO file to a virtual CD-ROM
1. In vSphere, display the vSphere client.

2. Select each of the three ProSphere virtual machines and connect the ISO file to the 
virtual machine with the Connect to ISO image on local disk option, as shown in 
the following figure. The three virtual machines are:

• DiscoveryAppliance

• HistoricalDatabase

EMC Update 
Repository

n/a “Select a virtual CDROM or web server for 
updates”  on page  121 explains how to 
configure the ProSphere update interface to use 
one of the URLs of the EMC Update Repository 
to obtain updates from the web. A different URL 
has the updates for each ProSphere virtual 
machine. Apply updates.

Specified Repository

Customer-installed 
web server

zip Create a web server for updates and configure a 
location where the web server will access the zip 
files. Go to EMC Online Support site URL 
provided by EMC. Download and unzip the zip 
files to the configured location. “Select a virtual 
CDROM or web server for updates”  on page 
 121 explains how to configure the ProSphere 
update interface to use the URL of the web 
server to obtain updates. Apply updates.

There is a separate zip file for each ProSphere 
virtual machine. 

Each zip file contains two folders, Manifest and 
Packages. The Manifest folder contains xml 
metadata files, and the Package folder contains 
the rpm packages that need to be updated.

Specified Repository

CD-ROM iso Go to an EMC Online Support site URL. 
Download an ISO file to a virtual CD-ROM as 
explained in “Download an ISO file to a virtual 
CD-ROM”  on page  119. 

“Select a virtual CDROM or web server for 
updates”  on page  121 explains how to 
configure the ProSphere update interface to 
obtain updates from a virtual CD-ROM. Apply 
updates.

Virtual CD-ROM 
Updates
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• StorageResourceManager.

After the ISO file is attached, the identification of updates can take a few minutes, 
unless the update check is forced.

Install updates on ProSphere
The following sections explain how to update ProSphere.

Note: After applying updates, some features of ProSphere may not work correctly until after 
arrays are rediscovered.

Create snapshots before updating software
Before applying an update, you should create a snapshot or backup of each of the 
ProSphere virtual machines. “Create and restore snapshots or backups”  on page  130 
provides more information about creating virtual machine snapshots and backups for 
ProSphere.

After applying updates to a ProSphere virtual machine, shutdown and restart the 
vApp. Follow the instructions in “Shut down or start up ProSphere or its virtual 
machines”  on page  131.

Note: ProSphere does not create rollback or backup points before applying updates. 
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Consult your VMware documentation for more information about creating backups 
and snapshots than what is presented here. VMware also provides documentation at 
http://www.vmware.com.

Select the EMC Update Repository as a source for updates
This section explains how to configure the source of manual updates as the EMC 
Update Repository on the web.

After logging in to ProSphere, perform the following:

1. Click Admin on the ProSphere Console.

2. Click the System tab. 

3. Click Manage Application Software.

4. Select a system component.

5. Click Specify Repository to open the Specify Repository dialog box.

6. Select Use EMC repository.

7. Type the URL from Table 10 on page 121. 

8. Enter username and password.

Note: A valid EMC Online Support username and password is required to access the EMC 
Update Repository.

Table 10 Update URL for ProSphere virtual machines

Virtual machine Update URL

Select a virtual CDROM or web server for updates
This section explains how to configure the source of manual updates as one of the 
following values:

◆ Use CD-ROM updates (if applying updates from an iso file)

◆ Use specified repository (if using a zip file)

After logging in to ProSphere, perform the following:

1. Click Admin on the ProSphere Console.

2. Click the System tab. 

3. Click Manage Application Software.

4. Select a system component.

5. Click Specify Repository to open the Specify Repository dialog box.

a. If you select Use CDROM updates, you will download the ISO file to a virtual 
CD-ROM as explained in Table 9 on page 119.

ProSphere Application https://vupdate.emc.com/StorageResourceManager

Discovery Engine https://vupdate.emc.com/DiscoveryAppliance

Historical Database https://vupdate.emc.com/HistoricalDatabase

Collector https://vupdate.emc.com/CollectorAppliance
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b. If you select Use specified repository, type the URL of the customer-installed 
web server where your virtual machine will look for updates. If the URL 
requires authentication, provide a valid username and password.

Receive updates reminder at login and apply updates
The system periodically checks for updates. 

If updates are available when you log in to ProSphere, the Software Updates 
Available dialog box is displayed to remind you.

Table 11 on page 122 describes the buttons available on the dialog box.

Table 11 Software Updates Available dialog box: buttons

Button Description

Note: Updates to ProSphere are available only in a new browser 
session. Therefore, after updates are applied, a message appears and 
prompts you to close the browser and reopen it.

You can disable the updates reminder with the following procedure:

1. Click Admin on the ProSphere Console.

2. Click the System tab. 

3. Click Manage Application Software. 

4. At the Manage Application Software dialog box, click Updates Reminder.

5. Select Only show updates in Manage Application Software dialogs.

Note: This option disables the automatic check for updates at login.

Update Software Displays the Update Software dialog box.
To apply updates, click the checkbox next to each update to apply, then 
click Install Updates.
After installing updates, if you have the Discovery Engine Collector 
deployed, click the Help button for the mandatory procedure. Otherwise, 
in the vSphere client, power off and reboot the ProSphere vApp. Follow 
the instructions in “Create and restore snapshots or backups”  on page 
 130. 

During the restart, a data migration operation is in progress, which will 
take from a few minutes to an hour depending on the amount of data 
involved. Periodically, you can log in to the ProSphere Console to check 
progress. If no message is displayed, assume the data migration 
operation was successful. If a failure message is displayed, contact 
Customer Support. 
Before data migration is complete, you see a message like the following:
Migration of data for <...> is still in 
progress. We suggest logging out and 
returning once migration is complete. If 
you continue, some functionality may not be 
available.

Remind Me Later Postpones the reminder.

No Reminder Prevents the reminder from reappearing.

Help Displays online help.
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6. Click OK, or click Close to close the dialog box without making changes.

Manually check for and apply updates
To manually check for updates:

1. Click Admin on the ProSphere Console.

2. Click the System tab. 

3. Click Manage Application Software.

If updates are available, the Health Details area on the Manage Application 
Software dialog box displays a message indicating that updates are available. If the 
attempt to check for updates did not succeed, details of the failed operation appear.

“Manage Application Software dialog box: buttons”  on page  123 discusses the 
buttons available on the Manage Application Software dialog box.

Table 12 Manage Application Software dialog box: buttons

Button Description

Note: Updates to ProSphere are available only in a new browser session. 
Therefore, after updates are applied, a message appears and prompts 
you to close the browser and reopen it.

Update Software Displays the Update Software dialog box.
To ensure that the most recent available updates are listed, click Check 
for New Updates.
To apply updates, click the checkbox next to each update to apply, then 
click Install Updates.
After installing updates, if you have the Discovery Engine Collector 
deployed, click the Help button for the mandatory procedure. Otherwise, 
in the vSphere client, power off and reboot the ProSphere vApp. Follow 
the instructions in “Create and restore snapshots or backups”  on page 
 130. 

During the restart, a data migration operation is in progress, which will 
take from a few minutes to an hour depending on the amount of data 
involved. Periodically, you can log in to the ProSphere Console to check 
progress. If no message is displayed, assume the data migration 
operation was successful. If a failure message is displayed, contact 
Customer Support.
Before data migration is complete, you see a message like the following:
Migration of data for <...> is still in 
progress. We suggest logging out and 
returning once migration is complete. If you 
continue, some functionality may not be 
available.

Specify Repository Selects a source for updates. “Select the EMC Update Repository as a 
source for updates”  on page  121 describes this button.

Update Reminder “Receive updates reminder at login and apply updates”  on page  122 
describes this button.

Close Closes the Manage Application Software dialog box without applying 
updates.

Help Displays online help.
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Update Prosphere, including the Greenplum database
How you monitor the progress of updates depends on the current stage of the update 
operation.

Export Greenplum database prior to ProSphere update
1. Take a VM snapshot of your existing ProSphere vApp.

2. Stop the srm-capacity-input service on the ProSphere SIP appliance:

a. Log onto the ProSphere SIP appliance

b. Run : # service srm-capacity-input stop

c. Verify that the service has been stopped:

# service --status-all | grep  srm-capacity-input
Checking for service: srm-capacity-input.. unused

3. Perform a pre-update Greenplum DB export

a. Log into the ProSphere Database appliance.

b. Locate a directory that has sufficient filesystem space to hold the DB export.

Note: Do not use a directory off of /data, as contents in this area are removed during the 
upgrade.

4. Perform the following commands:

su - gpadmin
pg_dump -a --format=custom --compress=9 historicalDB > 
/[directory from step 3b]/ historicalDB_cmp.bkp

Initiate the ProSphere Update
5. Initiate the update process from ProSphere Console > Admin > System > 

Manage Application Software.

6. Wait for the following message to appear:

7. Monitor the update progress for each ProSphere virtual machine:

a. Log into each virtual machine with a tool that uses SSH protocol, such as 
PuTTY.

b. Run the following command: 
 
tail /opt/vmware/var/log/vami/updatecli.log
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c. Confirm that updates on all the virtual machines are complete with these lines. 
 
[INFO] Update status: Done finalizing installation 
[INFO] Update status: Update completed successfully 
[INFO] Install Finished

Note: If the ProSphere Console has not timed out before update has completed on all the 
virtual machines, skip to step 6..
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8. If the ProSphere Console has timed out during the update, and you log into it 
before rebooting the ProSphere vApp, the following dialog box appears.

9. Click Logout and skip to step 7.
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10. Check for this message in the ProSphere Console, indicating that all virtual 
machines have been updated successfully:

11. Power off the ProSphere vApp.

Import Greenplum database
12. Power on the ProSphere DB vApp only.

13. Run a Greenplum import of the pre-update export from step #4.

14. Perform the following commands:

• su - gpadmin

• pg_restore -a -d historicalDB /[directory from step 
3b]/historicalDB_cmp.bkp > restore_cmp.txt 2>&1

15. Check the restore_cmp.txt file for any errors during the import. If there are 
errors contact EMC Cusomter Support.

Complete the ProSphere Update
16. Perform a “Guest shutdown” of the DB appliance.

17. Power on the entire ProSphere vApp.

18. This triggers the next stage of the update process — data migration.

19. Reboot any Discovery Engine Collector and Secondary ProSphere Application 
deployed.

Monitor the progress of data migration
During data migration, you can only log into the VMware Console to check the 
progress of data migration for each ProSphere virtual machine. You cannot log into 
the ProSphere Console.

CAUTION!
Do not reboot a ProSphere virtual machine until data migration is complete, or the 
entire update operation fails.

IMPORTANT!
Wait for reboot and data migration to complete on the master site before logging in 
to the non-master sites to ensure that all features affected by federation work as 
expected.

To monitor data migration:

1. Open the VMware Console from either vCenter or vCloud Director.
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2. For each ProSphere virtual machine, wait for all four steps of data migration (as 
illustrated in the example below) to complete. This may take an extended period 
of time depending on the size of the journal files being migrated.

3. Ensure that the login prompt appears for each virtual machine, as given in the 
example below.
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The login prompt in the VMware Console indicates that data migration is complete, 
and you can log into the ProSphere Console again.

Verify completion of the update process
1. Log into the ProSphere Console. The following message appears:

2. In Admin > System > Manage Application Software, check the update status for 
the ProSphere virtual machines. 
 
The value in the Last Updated column should indicate that the virtual machines 
are updated as shown in this example:
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3. Rerun all initial discovery jobs manually.

Impact of upgrades
The upgrade impacts the currently running performance data collection and alert 
collection jobs, causing them to fail.

To avoid discovery failure, create an SMC-SPA access credential in ProSphere to 
represent all SMC/SPA instances in the network. An SMC-SPA access credential 
allows ProSphere to be represented as a launch client in SMC. The launch client needs 
to be registered in all SMC/SPA instances.

Upgrading ProSphere from 1.5 to 1.6 or later can have the following results:
◆ Performance data collection may fail

◆ Alert collection jobs may fail

◆ Discovery jobs configured with default credentials are dissociated.

If array detection fails, the status of the array is displayed on the Performance 
Detection Failures link in Discovery Job Execution Results.

The reasons for failure can be:

◆ The SMC-SPA access credential was not created.

◆ The SMC-SPA access credential attributes do not match the information in the 
corresponding launch client in an SMC/SPA instance.

Follow the steps in “Integrate ProSphere with Unisphere for VMAX”  on page  105.

Create and restore snapshots or backups
Snapshots or backups of the ProSphere virtual machines ensure that you can return to 
the complete, previous working state of ProSphere in the event of a failed update.

Instead of using snapshots, your data center may use VMware Data Recovery as a 
backup solution for your virtual environment. “Back up and restore ProSphere with 
VMware Data Recovery”  on page  133 explains how to create backups with VMware 
Data Recovery.

IMPORTANT!
If more than one deployment is synchronized, we recommend that you schedule 
backups of synchronized sites so they start at the same time. This minimizes errors 
that result from sites being “out-of-sync.”

Note: Your VMware environment may have predefined policies related to the creation of 
snapshots and backups. Consult your VMware administrator before creating snapshots or 
backups of ProSphere virtual machines. The procedures presented here are only examples.
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Shut down or start up ProSphere or its virtual machines

IMPORTANT!
If a ProSphere vApp or virtual machine is improperly shut down, network 
configuration data may be lost, and the ProSphere virtual machine will be isolated 
from the network after powering on.  This is a known problem with VMware.

Table 13 on page 131 explains how to perform shutdowns and startups with 
right-click options from the vSphere Console.

Table 13 Shutdown and startup procedures from vSphere Console

Item To shut down use... To start up use...

Table 13 on page 131 explains how to perform shutdowns and startups with 
right-click options from the vSphere Console. Select a virtual machine or vApp, then 
use the specified command.

Table 14 Shutdown and startup procedures from vCloud Console

Item To shut down use... To start up use...

IMPORTANT!
Do not execute reboot from the command line or use Restart Guest from VMware 
tools. This may render the appliance unusable and result in an empty ovfEnv.xml 
which corrupts the /etc/hosts file with incorrect entries. 

IMPORTANT!
If a Collector is powered off directly without first properly shutting down the 
system, the ProSphere Console can hang. The recommended practice is to use the 
Shutdown Guest command in vCenter before powering off.

Create ProSphere snapshots in vSphere Client
To create a snapshot of each of the ProSphere virtual machines in the VMware 
vSphere Client:

1. Open the vSphere Client and connect to the vCenter Server managing the 
VMware environment in which ProSphere is running.

2. Navigate to the ProSphere vApp. You can find the vApp by entering a name in 
the Search Inventory search field. You can also navigate to the vApp in the 
Inventory Panel.

ProSphere virtual machine ShutDown Guest Power On

ProSphere vApp Power Off Power On

ProSphere virtual machine Stop Stop

ProSphere vApp Start Start
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Note: In a scale-out deployment, additional virtual machines of the Collector type exist, as 
described in the architecture chapter of the EMC ProSphere Administrator Guide. Shut down 
Collectors, then shut down the vApp. Shut down Collectors by first right-clicking each in the 
vSphere Console and then selecting Shutdown Guest.

3. Shut down the vApp by right-clicking it and then selecting Power Off. 

IMPORTANT!
Snapshots should not be taken if ProSphere is running.

4. Right-click the first virtual machine and select Snapshot > Take snapshot.

5. In the Take Virtual Machine Snapshot dialog box, enter a Name and Description 
for the snapshot.

6. Click OK to create the snapshot. The snapshot creation status is displayed in the 
Recent Tasks status bar.

7. Repeat steps 4 through 6 for each virtual machine in the ProSphere vApp.

8. When each snapshot displays a status of Completed, power on the ProSphere 
vApp. Right-click the ProSphere vApp and select Power On.

9. Restart any Collectors. Restart each Collector by right-clicking it in the vSphere 
Console and selecting Power On.

Roll back to a snapshot in vSphere Client
To roll back to a snapshot of a ProSphere virtual machine in the VMware vSphere 
Client:

1. Open the vSphere Client and connect to the vCenter Server managing the 
VMware environment in which ProSphere is running.

2. Navigate to the ProSphere vApp and select one of its virtual machines. You can 
find the vApp by entering a name in the Search Inventory search field. You can 
also navigate to the vApp in the Inventory Panel.

3. Right-click the virtual machine and select Snapshot, Snapshot Manager.

4. In the Snapshot Manager dialog box, select the name of the snapshot to roll back 
to and then click Go to.

5. Click Yes in the Confirm dialog box to proceed with the rollback.

Note: If rolling back a ProSphere virtual machine due to a failed update, EMC recommends 
rolling back each of the ProSphere virtual machines to a corresponding snapshot.

Note: If multiple instances of ProSphere are synchronized and one is rolled back to a snapshot, 
attempts to access details of objects discovered after the rollback occurred will return errors. 
The synchronization chapter of the EMC ProSphere Administrator Guide discusses this 
situation in detail.

Create ProSphere snapshots in vCloud Director
Use the following procedure to snapshot the ProSphere vApp.
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1. If you have any collectors or a Secondary ProSphere Application configured in 
the environment, power them off before powering off the vApp.

2. Power off the ProSphere vApp.

3. Click the My Cloud tab and choose the ProSphere vApp to snapshot.

4. Right click the vApp and select Create Snapshot.

5. If you have a Collector or a Secondary ProSphere Application deployed, repeat 
step 4.

Note: vCloud director currently supports only one snapshot. The previous snapshot will be 
overwritten if you take another snapshot. 

Roll back to a snapshot in vCloud Director
1. Click the My Cloud tab and select the ProSphere vApp to revert.

2. Right-click the vApp and select Revert to snapshot.

3. If you have a Collector or a Secondary ProSphere Application deployed, repeat 
step 2.

Back up and restore ProSphere with VMware Data Recovery
The VMWare Data Recovery Administration Guide explains how to back up and restore 
virtual machines. 

If VMware Data Recovery is used for backups, each virtual machine must have a 
name that differentiates it from all virtual machines in all deployments by a customer 
in a vCenter.

In a scale-out deployment, additional virtual machines of the Collector type exist, as 
described in the architecture chapter of the EMC ProSphere Administrator Guide. 
Schedule separate backup jobs for the vApp and for the Collector. Schedule these 
backups to occur at the same time. When restoring the virtual machines from 
backups, disable automatic power on the Collector so you can manually power it on 
after you power on and restore the Discovery Engine.

When backing up with VDR, move the Collectors inside the vApp container into 
Group1, along with other ProSphere machines. When you do this, by default the 
Shutdown Operation will be set to Power Off. This value does not permit a graceful 
shutdown of the Collector.

Perform the following step to allow the Collector to gracefully shut down: 

1. Select Edit Settings.

2. Select the Start Order tab. 

3. Under Shutdown Action, set the Operation to Guest Shutdown.
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4. Set Shutdown sequence proceeds when to 600. 

5. Click OK.
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